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Preface

Welcome to the Oracle Customer Relationship Management, Release 11i, suite of
applications.

This CRM Application Foundation Implementation Guide provides information
and instructions to help you effectively set up the Oracle CRM Foundation
modules.

This preface explains how the Implementation Guide is organized and introduces
other sources of information that can help you.

Intended Audience
This guide is aimed at the following users:

■ Oracle CRM business users

■ Customer Service Representatives

■ Field Service personnel

■ System Administrators

This guide assumes that you have the following prerequisites:

■ Understanding of the basic company business processes

■ Knowledge of products and services as defined by your marketing policies

This guide is aimed at the following users:

■ Technical Service Representatives

■ Customer Service Representatives
ix



■ System Administrators, Database Administrators, and others with similar
responsibility.

This guide assumes you have the following prerequisites:

■ Understanding of the company business processes

■ Knowledge of products and services as defined by your marketing policies

■ Basic understanding of Oracle and Developer/2000

■ Background in SQL, PL/SQL, SQL* Plus programming

Structure
This manual is a compilation of the implementation topics in the online help for
Oracle CRM Application Foundation components. It provides general descriptions
of the setup and configuration tasks required to implement the Oracle CRM
Application Foundation components successfully.

Related Documents
For more information on Oracle CRM Application Foundation, see the following
manuals:

■ Oracle CRM Foundation Concepts and Procedures

■ Oracle CRM Foundation Technical Reference Manual

Other Sources of Information
For additional information regarding the Oracle E-Business Suite, consult the
following:

■ Oracle Application Product Update Notes, Release 11

■ Installing Oracle Applications, Release 11

■ Maintaining Oracle Applications, Release 11

■ Oracle Application Concepts

■ Oracle Applications System Administrator’s Guide

■ Implementing Oracle CRM: ERP Functional Flows

■ Implementing Oracle CRM: Foundation Functional Flows
x



In addition, Oracle offers several relevant courses through Oracle University:

■ 11i Use and Administer Oracle CRM Foundation

■ 11i Implement Oracle CRM Foundation

Documentation Accessibility
Our goal is to make Oracle products, services, and supporting documentation
accessible, with good usability, to the disabled community. To that end, our
documentation includes features that make information available to users of
assistive technology. This documentation is available in HTML format, and contains
markup to facilitate access by the disabled community. Standards will continue to
evolve over time, and Oracle Corporation is actively engaged with other
market-leading technology vendors to address technical obstacles so that our
documentation can be accessible to all of our customers. For additional information,
visit the Oracle Accessibility Program web site at
http://www.oracle.com/accessibility/.

Accessibility of Code Examples in Documentation
JAWS, a Windows screen reader, may not always correctly read the code examples
in this document. The conventions for writing code require that closing braces
should appear on an otherwise empty line; however, JAWS may not always read a
line of text that consists solely of a bracket or brace.
xi



xii



Implementing Territory Manager

This topic group provides general descriptions of the setup and configuration tasks
required to implement the application successfully.

This section covers the following topics:

■ Related Documentation and Resources

■ Setting Up Territory Manager

■ Territory Planning

■ Enabling Existing Qualifiers

Related Documentation and Resources
You may also want to consult the following documentation:

■ Oracle Applications, Product Update Notes, Release 11i

■ Installing Oracle Applications, Release 11i

■ Implementing CRM Applications

■ Oracle CRM Foundation Components Concepts and Procedures

■ Oracle CRM Foundation Technical Reference Manual

These documents range from the general to the specific, in the order listed in the
following table.
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Setting Up Territory Manager
Related Courseware
The following Net Class is available on demand through Oracle University.

■ 11i Overview of Implementing Foundation, Course Description ID 8831.

Setting Up Territory Manager
Prior to using Territory Manager, you must set up and configure a number of items
including, territory types and the specific territories.

Prerequisites
None

Steps
Perform the steps following to set up the Territory Manager.

Related Documentation

Document Purpose

Oracle Applications, Product Update Notes,
Release 11i

Contains information about new product features and
functions for the various Oracle applications

Installing Oracle Applications, Release 11i Documents the Rapid Install installation process

Implementing CRM Applications, A853401-01 Contains post-installation information on various CRM
modules

Oracle CRM Foundation Components,
Concepts and Procedures

A printed compilation of the Oracle Foundation online help
system

Oracle CRM Foundation, Technical Reference
Manual

Contains table and view descriptions for all the Foundation
components

Step Required? Action Window Name(s)

1 Yes Territory Planning is the first step in the Territory
Manager process. Typically, a planning team
analyzes the territory setup in the organization.

n/a

2 Yes Enable existing Transaction Qualifiers first before
using them.

Setup Qualifier
Window
2 Oracle CRM Application Foundation Implementation Guide



Territory Planning
Territory Planning
Before using the Territory Manager module, you must analyze the territory setup in
your organization. This is typically done by a planning team comprised of but not
limited to: management, consultants, and other key players. You need
enterprise-wide cooperation and feedback and you must expect to make multiple
territory revisions in the first months of operation as your enterprise discovers
omitted information or territories that do not work on a day-to-day basis.

The following are the typical steps to follow in the planning process.

Steps
1. Review your existing territories.

You need the following types of information:

■ How your territories are currently assigned (by state, by industry, by zip
code, by account, and so on)

■ The names and current territory assignments for your sales or service
personnel

■ The names of employees in other organizations who receive account, lead,
and opportunity information and how that information is accessed and
used

■ Your products and how they are differentiated

2. Decide what qualifiers you want to use to assign to territories and create
territory types (optional) to restrict your territory restrictions.

3. Decide on the hierarchy of territories.

4. Decide if escalation territories are needed and how they fit in the hierarchy.

5. Decide what qualifier values to use for assigning territories.

6. Identify any overlapping territories and decide the order in which the
application chooses them.

Note: Remember that Oracle Sales and Oracle Telesales use the
same rules for assigning leads or opportunities.
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Enabling Existing Qualifiers
■ Rank any overlapping territories from 1 to n to determine the order. A
territory with a smaller rank wins over a territory with a higher rank. In
case of a tie, the assignment is made randomly.

7. Test the strategy before implementing territories throughout the company and
consider any future territory maintenance efforts.

In general, there is no limitation on territory creation. Create as many territories as
you want for your business. However, in considering the purpose of future territory
maintenance, for example, you need to modify territories due to sales, service, or
support people changes or relocations, as well as organizational changes. You need
to have a reasonable size of territories to minimize the efforts of territory
management.

Enabling Existing Qualifiers
Territory Manager has predefined qualifiers for:

■ Defect Management

■ Sales and Marketing

■ Service

■ Service Contracts

■ Trade Management

Before using any of the transaction qualifier, you need to enable them.

Unlike the transaction qualifiers classified by the territory usage, resource qualifiers
are shared throughout the application regardless of territory usage except for
Service Contracts. Therefore, you do not need to enable them.

Perform the following steps to enable the existing transaction qualifiers.

Prerequisites
None

Note: Remember that the first territory setup is not necessarily the
one that works best. You achieve optimum territory definition only
gradually after much fine-tuning to accommodate user reactions
and various interests in your organization.
4 Oracle CRM Application Foundation Implementation Guide



Enabling Existing Qualifiers
Steps
1. In the CRM Administrator responsibility, navigate to Territory Manager >

Territory Administration.

The Navigator window opens.

2. Select Administration from the drop down menu and choose Setup Qualifiers.

The Setup Qualifier window opens.

3. Select the Usage drop-down list.

The Select Usage window opens.

4. Highlight your selection and click OK.

The Setup Qualifier window opens and the Usage Field is populated with your
selection.

5. Select Find.

You can also select appropriate qualifier status (Enabled, Disabled or All) before
finding them. Note that all resource qualifiers are not listed here.

6. Check (or uncheck) the targeted qualifiers and select Update Qualifiers.

Detailed information on how to enable existing qualifiers is addressed in the 11i
Implement CRM Foundation course.

See Also
■ Qualifiers

■ List of Predefined Territory Qualifiers
Implementing Territory Manager 5
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Implementing Resource Manager

This topic group provides general descriptions of the setup and configuration tasks
required to implement the application successfully. This section covers the
following topics:

■ Related Documentation and Resources

■ Setting up Resource Manager

■ Defining Role Types

■ Defining Resource Roles

■ Setting Profile Options

■ Workflows in Resource Manager

Related Documentation and Resources
You may also wish to consult the following documentation:

■ Oracle Applications, Product Update Notes, Release 11i

■ Installing Oracle Applications, Release 11i

■ Implementing CRM Applications

■ Oracle CRM Foundation Components, Concepts and Procedures

■ Oracle CRM Foundation Technical Reference Manual

These documents range from the general to the specific, in the order listed in the
following table.
Implementing Resource Manager 7



Setting Up Resource Manager
Setting Up Resource Manager
In addition to the pre-defined Role Types and Role Information, you can define new
Role Types and Roles. The following tables outlines the steps involved in setting up
the Resource Manager.

Steps

Defining Role Types
A Role Type is a category of roles associated with a particular CRM module.
Resource Manager is delivered with pre-defined Role Types for all CRM modules.
Perform the following steps to define additional custom Role Types for your
enterprise. Make sure that a role type exists with which you can associate the new
role.

Steps
1. In the CRM Administrator responsibility, navigate to Resource Manager >

Setup > Role Types.

Related Documentation

Document Purpose

Oracle Applications, Product Update Notes,
Release 11i

Contains information about new product features and
functions for the various Oracle applications

Installing Oracle Applications, Release 11i Documents the Rapid Install installation process

Implementing CRM Applications, A85301-01 Contains post-installation information on CRM modules

Oracle CRM Foundation Components,
Concepts and Procedures

A printed compilation of the Oracle Foundation online help
system

Oracle CRM Foundation, Technical Reference
Manual

Contains table and view descriptions for all the Foundation
components

Step
Number Required?

Resource Manager Setup
Step Description Window Name(s) AIW Reference

❏ 1 Optional Define Role Types Application Object Library:
JTF_RS_ROLE_TYPE Lookups

N/A

❏ 2 Optional Define Resource Roles Roles N/A
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Defining Resource Roles
The Application Object Library: JTF_RS_ROLE_TYPES Lookups window
displays existing Role Types.

2. Use the down arrow to scroll to the bottom of the list of Role Types.

3. Select the last entry in the record and choose File > New to add a blank field.

4. Enter the name of the new Role Type in the blank field at the bottom of the list.

5. In the Meaning field, enter the CRM module for which this Role Type is created.

6. Choose File > Save to complete the Role Type definition.

Defining Resource Roles
A Role may encompass one or more job descriptions and job titles. Use Roles to
assign responsibilities to resources, resource groups and resource teams. Resource
Manager is delivered with pre-defined Roles for all CRM modules. Perform the
following steps to define additional custom Roles for your enterprise.

Prerequisites
Make sure that a Role Type exists with which you can associate the new Role.

Steps
1. In the CRM Administrator responsibility, navigate to Resource Manager >

Setup > Roles.

The Roles window opens and displays fields you can use to define a role.

2. Enter your values in the Code and Name fields. Choose a Role Type from the
list of values (LOV).

3. Select the Active box to make the Role active. Select one or more of the role
attribute check boxes–Member, Lead, Admin, Manager–to associate the Role to
a responsibility. See the Resource Roles Attributes table in the References
section for descriptions of these role attributes.

4. Use one or more Job names in the job region to describe jobs associated with the
Role.

5. Select File > Save to complete the Role definition.

The new role name registers in the Role Name field in Resource Manager.
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Defining Dynamic Groups
Guidelines

See Also
Defining Dynamic Groups

Defining Dynamic Groups
Determine the group values available to the user in Resource Manager. By defining
the name, usage values, and effective dates of a group. Perform the following steps
to define a dynamic group.

Prerequisites
None

Steps
1. In the CRM Administrator responsibility, navigate to Resource Manager >

Maintain Resources > Dynamic Groups.

The Dynamic Groups window opens.

2. Enter a group name in the Name field.

3. Select a group usage from the Usage field.

4. Select the effective dates for the group from the list of values (LOV) in the Start
and End fields.

5. Enter a brief description of the group name and usage in the Description field.

6. Enter the SQL statement to define a group.

Resource Role Attributes

Check Box Action

Member This check box identifies the role name as a member of the role.

Lead This check box identifies the role name as a lead for the role.

Active This check box identifies the role as active.

Admin This check box identifies the role as administrative.

Manager This check box identifies the role as managerial.

Seeded (Read Only) This check box identifies the role as seeded.
10 Oracle CRM Application Foundation Implementation Guide



Workflows in Resource Manager
7. Click Check Syntax to check the code for syntax errors.

8. Choose File > Save to save the group.

The new group name registers in the Group Name field in Resource Manager.

See Also
Defining Resource Roles

Setting Profile Options
Resource Manager does not use profile options.

Workflows in Resource Manager
Resource Manager does not use Workflow processes manager.
Implementing Resource Manager 11
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Implementing Notes

This topic group provides general descriptions of the setup and configuration tasks
required to implement the application successfully. This section covers the
following topics:

■ Related Documentation and Resources

■ Post-Installation Set Up Tasks for Oracle Notes

■ Setting Up Note Types

■ Defining Note Types

■ Mapping Note Types To a Source

■ Setting Up the Source Object Code and Context

■ System Profile Options

Related Documentation and Resources
You may also wish to consult the following documentation:

■ Oracle Applications, Product Update Notes, Release 11i

■ Installing Oracle Applications, Release 11i

■ Implementing CRM Applications

■ Oracle CRM Foundation Components Concepts and Procedures

■ Oracle CRM Foundation Technical Reference Manual

These documents range from the general to the specific, in the order listed in the
following table.
Implementing Notes 13



Post-Installation Set Up Tasks for Oracle Notes
Related Courseware
The following Net Class is available on demand through Oracle University.

■ 11i Overview of Implementing Foundation, Course Description ID 8831.

Post-Installation Set Up Tasks for Oracle Notes
After the Foundation modules have been installed, you may perform the following
optional tasks listed in the table below.

Setting Up Note Types
Notes comes with a set of predefined note types. You can create additional
customized note types. You may also choose to not use the predefined note types
Perform the following steps to create new note types.

Related Documentation

Document Purpose

Oracle Applications, Product Update Notes,
Release 11i

Contains information about new product features and
functions for the various Oracle applications

Installing Oracle Applications, Release 11i Documents the Rapid Install installation process

Implementing CRM Applications, A85301-01 Contains post-installation information on CRM modules

Oracle CRM Foundation Components,
Concepts and Procedures

A printed compilation of the Oracle Foundation online
help system

Oracle CRM Foundation, Technical Reference
Manual

Contains table and view descriptions for all the Foundation
components

Step
Number Required?

Oracle Notes Setup
Step Description Window Name(s)

❏ 1 Optional Set Up Note Types Notes Setup > Note Type
Lookups

❏ 2 Optional Map Note Types to a Source Notes Setup > Source and
Note Type Mapping

❏ 3 Optional Set Up the Source Object Code Task and Escalation
Manager > Setup
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Defining Note Types
Prerequisite
You must log on under the CRM Administrator account to perform this task.

Steps
1. Select CRM Administrator from the list of logon responsibilities.

The CRM Administrator Navigator opens.

2. Expand the Notes Setup node.

3. Select Note Type Setup

The Application Object Library: Note Type Lookups form window opens.

4. Define the code, meaning, and description as desired.

You only need to define a tag for a new, customized note type.

5. Save this record when you have finished.

Defining Note Types
You can configure Notes to limit the choices of task type. When you provide a LOV
for the Note Type fields, the note creator cannot enter an incorrect value, Instead,
the user chooses from a pre-defined menu of note types. Use this procedure to
define note types for your users.

Prerequisites
None

Steps
1. On the application menu bar, click File and select Switch Responsibility.

The Responsibilities window opens.

2. Scroll to select Application Developer and click OK.

The Navigator - Application Developer window opens.

3. In the Functions tab, double-click Application to expand the node.

Note: To delete an existing note type, assign an end date to that
note type.
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Mapping Note Types To a Source
4. Double-click Lookups to expand the node.

5. Select Common and click Open.

The Application Utilities Lookups window opens.

6. On the application menu bar, click View, point to Query by Example, and click
Enter.

7. In the Type field, enter JTF_NOTE_TYPE.

8. On the application menu bar, click View, point to Query by Example, and click
Run.

The application populates the window with existing type code information.

9. Scroll down and select the last record in the multi-record block.

10. Define and enter the code, meaning, description, and effective dates.

11. Save your record.

The new note type registers in the LOV for the note type field in the application.

Guidelines
Choose to enable note types by selecting Enabled for the corresponding note type
row. Initially you can create the complete set of note types, and enable the specific
types as desired.

Mapping Note Types To a Source
When you may map a note type to a source object, you limit the visible note types
for that source to the defined subset of note types. Perform the following steps to
map note types to source code.

Prerequisite
You must log on under the CRM Administrator account to perform this task.

Steps
1. Select CRM Administrator from the list of logon responsibilities.

The CRM Administrator Navigator opens.

2. Expand the Notes Setup node.

3. Select Source and Note Type Mapping.
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Setting Up the Source Object Code and Context
The Source to Type Mappings form window opens.

4. Select a source to map from the Source LOV.

5. Select a note type to map to it from the Note Type LOV.

6. Save this record when you have finished.

Setting Up the Source Object Code and Context
Notes provides predefined documents or source objects. When you define a new
document, you must associate Notes usage to the new document. On the Notes
form, the document name appears in the Source list. Each item in the Source list has
an associated context, which appears in the Related To list.

Perform the following steps to define the source code usage as NOTES.

Prerequisite
You must log on under the CRM Administrator account to perform this task.

Steps
1. Select CRM Administrator from the list of logon responsibilities.

The CRM Administrator Navigator opens.

2. Expand the Task and Escalation Manager node.

3. Expand the Setup node.

4. Double-click Objects Meta-data.

The Tasks Setup: Object Type form window opens.

5. Perform one of the following tasks:

a. If the source object code you want to seed already exists, then define the
usage as NOTES.

b. If the source object code is not defined, then you must define the source
object code, the name, and select its details and usage. (Usage should be
NOTES.)

6. Save this record when you have finished.
Implementing Notes 17



System Profile Options
System Profile Options
Use the following list to identify the profile option(s) that you need to set for your
specific implementation. You can set these profile options in any order you like.

■ Notes: Default Note Status

To change profile options, use the standard procedure outlined in the Oracle
Applications Users Guide.

Profile Option Notes: Default Note Status
The following table details the profile option, which sets the default note status.

Required

User can Admin Setting Levels

View Update User Responsibility Application Site

X X X X X X X

Setting Description and Usage Considerations

User chosen Chose the default note status from the provided LOV.
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Implementing Calendar

This topic group provides general descriptions of the set up and configuration tasks
required to implement the application successfully. This section covers the
following topics:

■ Related Documentation and Resources

■ System Profile Options

■ Defining a Calendar

Related Documentation and Resources
You may also wish to consult the following documentation:

■ Oracle Applications, Product Update Notes, Release 11i

■ Installing Oracle Applications, Release 11i

■ Implementing CRM Applications

■ Oracle CRM Foundation Components Concepts and Procedures

■ Oracle CRM Foundation Technical Reference Manual

These documents range from the general to the specific, in the order listed in the
following table.
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System Profile Options
System Profile Options
Use the following list to identify the profile options that you need to set for your
specific implementation. You can set these options in any sequence.

■ JTF_CAL_ACCESS_ALL_CALENDARS

To change profile options, use the standard procedure outlined in the Oracle
Applications Users Guide.

Profile Option JTF_CAL_ACCESS_ALL_CALENDARS
The following table details JTF_CAL_ACCESS_ALL_CALENDARS, which is set to
provide access to other Resources’ calendars.

Defining a Calendar
See the following procedures for defining and maintaining calendars:

■ Defining the Calendar

■ Defining Availability (of resources)

Related Documentation

Document Purpose

Oracle Applications, Product Update Notes,
Release 11i

Contains information about new product features and functions
for the various Oracle applications

Installing Oracle Applications, Release 11i Documents the Rapid Install installation process

Implementing CRM Applications, A85301-01 Contains post-installation information on CRM modules

Oracle CRM Foundation Components,
Concepts and Procedures

A printed compilation of the Oracle Foundation online
help system

Oracle CRM Foundation, Technical
Reference Manual

Contains table and view descriptions for all the Foundation
components

Required

User can Admin Setting Levels

View Update User Responsibility Application Site

X X X X X X X

Setting Description and Usage Considerations

Y/N Default is No.
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Defining a Calendar
■ Defining Non-availability

■ Assigning a Resource to a Calendar

■ Assigning a Calendar to a Shift

■ Assigning a Calendar to an Exception

■ Viewing the Datebook
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Defining a Calendar
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Implementing Task Manager

This topic group provides general descriptions of the setup and configuration tasks
required to implement the application successfully. This section covers the
following topics:

■ Dependencies for Tasks

■ Related Documentation and Resources

■ Setting Up Oracle Tasks

■ Defining Task Status

■ Determining Task Priority

■ Defining Task Types

■ Defining a Status Transition and Assigning Rules

■ Designing Task Templates

■ Workflows

Dependencies for Tasks
The following Foundation modules must be implemented before implementing
Oracle Tasks:

■ Resource Manager

■ Territory Manager

■ Calendar
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Related Documentation and Resources
Related Documentation and Resources
You may also wish to consult the following documentation:

■ Oracle Applications, Product Update Notes, Release 11i

■ Installing Oracle Applications, Release 11i

■ Implementing CRM Applications

■ Oracle CRM Foundation Components Concepts and Procedures

■ Oracle CRM Foundation Technical Reference Manual

■ Oracle Workflow Guide

These documents range from the general to the specific, in the order listed in the
following table.

Setting Up Oracle Tasks
Oracle Tasks comes ready to use out-of-the-box, with a number of functions
pre-defined for you. However, if desired, you can easily customize Oracle Tasks to
meet your business needs.

Prerequisites
First install Oracle Tasks.

Steps
Perform the following tasks, listed in the following table, to customize Oracle Tasks
for your specific needs.

Related Documentation

Document Purpose

Oracle Applications, Product Update Notes,
Release 11i

Contains information about new product features and
functions for the various Oracle applications

Installing Oracle Applications, Release 11i Documents the Rapid Install installation process

Implementing CRM Applications, A85301-01 Contains post-installation information on CRM modules

Oracle CRM Foundation Components,
Concepts and Procedures

A printed compilation of the Oracle Foundation online
help system

Oracle CRM Foundation, Technical Reference
Manual

Contains table and view descriptions for all the Foundation
components
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Defining Task Status
Defining Task Status
Limit the user’s choices of task status by defining the list of status options and
determining the employee type that has access to each status type. When you
provide a LOV for the Task Status field, task creators choose from a pre-defined
template of status options. Use this procedure to define types of task status for your
users.

Step Required? Action Window Name(s)

1 Optional Create new Task Statuses if you want to
customize task statuses.

See Defining Task Status for details.

Define Task Status

2 Optional Create new Task Priorities if you want to
customize task priorities.

See Determining Task Priority for details.

Define Task Priorities

3 Optional Create new Task Types if you want to
customize task types.

See Defining a Task Type for details.

Define Task Types

4 Optional Use the status transition model to restrict the
status assigned to a task depending on the
responsibility.

Set up the state transition model for each
responsibility.

Define Task Statuses,
click Define
Transition

5 Optional Create new task date types.

The task data model provides three
pre-defined date types:

■ Planned

■ Scheduled

■ Actual

However, depending on the usage,
additional dates can be required.

For example, if a lead requires a follow-up
date, you might set up a Follow-up Date
type.

Define Date Types

6 Optional Use templates if the same set of tasks are
created repeatedly.

See Designing Task Templates for details.

Define Templates
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Defining Task Status
Prerequisites
None

Steps
1. In the Tasks window, click Navigator on the Task toolbar.

2. In the Task Manager Navigator, double-click Setup to expand the node.

3. Select Task Status and click Open.

The Task Status window opens.

4. Define a type name and enter it in the Status field.

5. Enter a brief description of the status type in the Description field.

6. Enter the effective dates in the From and To fields.

7. Select task status flags.

For a detailed description of flag options, see the Task Status Flag Definitions
table in the References section.

8. Optionally, define transition values that determine the user privilege for each
status type.

Use this procedure to define transition values.

a. Click State Transition.

The State Transition window opens.

b. In the Rules tab, enter a name for the user privilege relationship in the Rule
Name field.

c. Enter an initial and final status type for the user.

Use the initial and final status values to determine the user’s range for
selecting task status.

d. In the Responsibility tab, enter the pre-determined rule name.

e. Enter a user type in Responsibility Name field and click OK.

A transition value stipulating user status privilege now exists.

9. Save your task status type.

The new task status and corresponding privileges register as lists of values for
their fields in the application.
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Determining Task Priority
References
The following table defines each task status flag.

See also
Defining a Status Transition and Assigning Rules

Determining Task Priority
Determine task priority by choosing terms for varying levels of priority and setting
an importance rating that corresponds with each term. Use this procedure to
determine task priority for your users.

Prerequisites
None

Steps
1. In the Tasks window, click Navigator on the Task toolbar.

2. In the Task Manager Navigator, double-click Setup to expand the node.

Task Status Flag Definitions

Flag Definition

Assigned Assigned to an individual

Working In progress

Schedulable Scheduled or re-schedulable

Accepted Accepted by owner

Rejected Rejected by owner

On Hold Temporarily not active

Approved Approved by management

Completed Completed by owner

Cancelled Cancelled by owner, creator, or management

Delete Allowed Delete acceptable without cancellation

Closed Completed and closed

Seeded Pre-defined task status
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Defining Task Types
3. Select Task Priority and click OK.

The Task Priority window opens.

4. Define a name and enter it in the Priority field.

5. Enter a numerical value in the Importance field.

Choose an importance value from a larger defined scale of priority.

6. Enter a brief description of the priority value.

7. Enter the effective dates in the From and To fields.

8. Select Seeded to restrict the edit of task priority from future users.

9. Save your task type.

The new task priority registers as a lists of value for the Priority field in the
application.

Defining Task Types
You can configure Task Manager to limit the user’s selection of task types. When
you provide a LOV for the Task Type field, the task creators cannot enter an
incorrect value. Instead they choose from a pre-defined menu of task options. Use
this procedure to define task types.

Prerequisites
None

Steps
1. In the Tasks window, click Navigator on the Task toolbar.

2. In the Task Manager Navigator, double-click Setup to expand the node.

3. Select Task Types and click OK.

The Task Types window opens.

4. Define a name and enter it in the Type field.

5. Select from the LOV in the Workflow field.

The corresponding workflow path information populates the Task Workflow
and Description fields.

6. Enter the effective dates in the From and To fields.
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Defining Task Types
7. Enter a unit of measurement for effort in the UOM field.

Use a measure of time to determine the UOM value.

8. Enter a number for the quantity of effort in the Qty field.

9. Select task type flags.

For a detailed description of flag options, see the Task Type Flag Definitions
table in the References section.

10. If you want to define resource requirements from the Task Types window, then
use this procedure.

a. Click Resource Requirement.

The Resource Requirements window opens.

b. Enter a resource name in the Name field.

c. Enter a number in the Required Units field.

Selecting the Enabled Flag activates the resource type for the corresponding
task type.

d. Click OK.

The complete set of resource types now exists and register as lists of values
for their task types when enabled.

11. Save your task type.

The new task type and corresponding resource types register as lists of values
for their fields in the application.

References
The following table defines each task type flag.

Task Type Flag Definitions

Flag Definition/Action

Notification Launch notification workflow automatically.

Schedulable Reserve the resource via the Scheduler.

Billable Signify a task as a service that requires billing.

Private Restrict task availability.

Seeded Lock edit of task type from future users.
Implementing Task Manager 29



Defining a Status Transition and Assigning Rules
Defining a Status Transition and Assigning Rules
In Tasks, you can define a group of tasks that must be performed and impose a
sequence of statuses to the tasks. A status transition is the imposed sequence of
statuses.

For example, one status transition may dictate the following status sequence:

■ Open

■ Assigned

■ Working

■ Closed

As each status in the sequence is completed, the subsequent status appears on the
agent’s list.

In addition, you can define rules for each status transition. A status transition rule
defines access and read-write privileges for the status transition. Rules can be
associated to responsibilities, so that a manager may have more privileges than an
agent.

Use the following procedure to define a status transition and assign it to a
responsibility.

Prerequisites
Responsibilities must be created for the applications to which you are assigning
Task Status and Task Status Transitions.

Steps
1. Login to the CRM Administrator responsibility.

2. Navigate to Task Manager > Setup > Task Status.

The Task Status window opens.

3. Click Define Transition.

The Status Transition window opens.

4. Click the Rules tab and click the Rule Name field.

5. Select View > Find All to populate the Rules tab.
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Designing Task Templates
The Rules tab displays two lists: Current State and Next State. On any line, the
task in the Next State list defines the task that immediately follows the task in
the Current State list. Use this window to define the sequence of tasks in a rule.

6. To define a new rule, enter a value in the Rule Name field.

7. Click the Responsibilities tab to assign a Rule to a Responsibility.

8. Click OK to complete the association of rule to responsibility.

Designing Task Templates
Design a task template to assist the application user in creating tasks. Creating a
template eliminates the user’s interaction with the specific properties of a task and
makes task creation a simple and quick process when creating redundant task
types. Use this procedure to design task templates.

Prerequisites
None

Steps
1. In the Tasks window, click Navigator on the Task toolbar.

2. In the Task Manager Navigator, double-click Tasks to expand the node.

3. Select Task Template Group and click OK.

The Task Template Group window opens.

4. Define and enter a template group name, description and effective dates.

5. Enter a document type by selecting from the LOV.

6. Define and enter a template name, number, and description.

7. Select from the LOV in the Type, Status, and Priority fields.

8. Activate alarm and notification functions, and enter duration and planned
effort values.

9. Select flags.

10. Optionally, click Dependencies and Recurrences.

The Task Details window opens.

11. Save your template.
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System Profile Options
A task template now exists and task creation from a template is possible.

Guidelines
Create task templates within groups. Each task template group contains related task
templates with full property descriptions.

References
Linking Tasks to Source Documentation

Defining Task Type

Defining Task Status

Determining Task Priority

Setting Task Flags

Setting Dependencies for Tasks

Assigning and Scheduling Resources

Creating and Updating Tasks

System Profile Options
Task Manager does not use profile options.

Workflows
Oracle Tasks contains one pre-defined workflow:

■ JTFTASK

This workflow can only send notifications to resources the resouce category
Employee. It will not send any notofication to any other type of resources like such
as groups or teams. If you want to send notifications to other type of resources, you
have to write your own workflow. JTFTASK is automatically launched under the
following circumstances.

■ If the auto-notification flag for the task type is set to Y (Yes).

■ If certain pre-defined conditions are met.
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Implementing Interaction History

This topic group provides general descriptions of the set up and configuration tasks
required to implement the application successfully.

The topics covered in this group include:

■ Release Dependencies

■ Related Documentation and Resources

■ Setting Up Interaction History

■ Troubleshooting Implementing of Interaction History

■ Setting Up Profile Options

■ Workflows in Interaction History

Release Dependencies
Before Interaction History is installed, these items must be installed and stable:

■ Oracle CRM Foundation (JTF) Resource

■ JTF Tasks

■ Oracle Accounts Receivable/Technical Community Architecture (AR/TCA)
Customer Model

■ Oracle Automated Marketing Services (AMS) Campaigns

Implementation of Interaction History starts with:

■ The graphical user interface, either Forms or JSP versions

■ Interaction History Administration, either Forms or JSP versions, or public APIs
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Related Documentation and Resources
Interaction History interacts with JTF Resource; JTF Tasks; AR/TCA Customer
Model; AMS Campaigns.

Related Documentation and Resources
You may also wish to consult the following documentation:

■ Oracle Applications, Product Update Notes, Release 11i

■ Installing Oracle Applications, Release 11i

■ Implementing CRM Applications

■ Oracle CRM Foundation Components Concepts and Procedures

■ Oracle CRM Foundation Technical Reference Manual

These documents range from the general to the specific, in the order listed in the
following table.

Setting Up Interaction History

Overview
Interaction History is a collection of tables and business logic that records touch
points between customers and resources for Oracle Applications. Whether the touch
point occurs between two computers, a face-to-face conversation, or over various
media channels (such as telephony), the following patterns are true:

■ A touch point is recorded as an interaction

Related Documentation

Document Purpose

Oracle Applications, Product Update Notes,
Release 11i

Contains information about new product features and
functions for the various Oracle applications

Installing Oracle Applications, Release 11i Documents the Rapid Install installation process

Implementing CRM Applications, A85301-01 Contains post-installation information on CRM modules

Oracle CRM Foundation Components,
Concepts and Procedures

A printed compilation of the Oracle Foundation online
help system

Oracle CRM Foundation, Technical Reference
Manual

Contains table and view descriptions for all the Foundation
components
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Setting Up Interaction History
■ An interaction is composed of a set of one or more business activities

■ An interaction is historical record, once created it cannot be altered or modified

■ Business activities can be related to a media item (such as phone, e-mail, or fax)

Prerequisites
Interaction History is part of the Oracle CRM Application Foundation product
suite. After CRM Application Foundation is installed, clients can access the
Interaction History graphical interface, Administration, and public APIs to test and
use Interaction History functionality.

The following table defines the procedure for setting up Interaction History.

Steps

Step
Number Required?

Interaction History Setup
Step Description

Window
Name(s) AIW Reference

1 Optional Define additional Outcome Codes required by
the application in addition to the initial seeded
values. Modify or delete existing Outcome
Codes.

Outcomes Tab CRM Administrator

Interaction History
Administrator

2 Optional Define additional Result Codes required by the
application in addition to the initial seeded
values. Modify or delete existing Result codes.

Result Tab CRM Administrator

Interaction History
Administrator

3 Optional Define additional Reason Codes required by the
application in addition to the initial seeded
values. Modify or delete existing Reason Codes

Reason Tab CRM Administrator

Interaction History
Administrator

4 Optional Define additional Action Item Codes required
by the application in addition to the initial
seeded values. Modify or delete existing Action
Item Codes.

Action Item
Tab

CRM Administrator

Interaction History
Administrator

5 Optional Define additional Action Codes required by the
application in addition to the initial seeded
values. Modify or delete existing Action codes.

Action Tab CRM Administrator

Interaction History
Administrator

6 Optional Define the Outcome, Result, and/or Reason
codes as required for specific campaigns and
promotions.

Wrap Up Tab CRM Administrator

Interaction History
Administrator
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Setting Up Interaction History
Guidelines
All applications that have a touch point between a customer and resource must
record this event as an interaction via Interaction History or another application
serving as a proxy that uses Interaction History (for example, Universal Work
Queue). Interaction History records can be browsed and retrieved by directly using
its graphical interface, integrating its graphical interface into an application, or
using its views. Use the Administration tool to modify setup data; do not modify
Interaction History tables directly.

Browsing and retrieval of interactions can be integrated by invoking the Interaction
History graphical interface directly from an application, integrating the Interaction
History graphical interface into an application, or using Interaction History views
and displaying the results as needed by the application.

Upon initiating a touch point, an interaction is created to serve as a repository for a
set of business activities that will occur during the lifetime of the touch point. When
a business activity is initiated, it is added to the interaction. After all business
activities for the interaction are completed the interaction is closed, making it a
historical record. Interactions can be browsed and retrieved during future active
touch points or for business intelligence analysis. Media items associated with a
business activity of an interaction are created before the interaction.

Concerns
Interaction History does not have any organizational constraints on operations or
relationships. Interaction History does not have any multi-organizational tables.

Interaction History schema does not contain any table columns that are related to
currency. Interaction History does have five translated tables which are used by
applications for creating interactions and activities: JTF_IH_OUTCOMES; JTF_IH_
RESULTS; JTF_IH_REASONS; JTF_IH_ACTION_ITEMS;
JTF_IH_ACTIONS.

7 Optional Define unique pairs of Outcome-Results from
existing Codes in the Outcome and Result
tables.

Outcome
Results

CRM Administrator

Interaction History
Administrator

8 Optional Define unique pairs of Result-Reason from
existing Codes in the Result and Reason tables.

Result Reasons CRM Administrator

Interaction History
Administrator

Step
Number Required?

Interaction History Setup
Step Description

Window
Name(s) AIW Reference
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Troubleshooting Implementation of Interaction History
Troubleshooting Implementation of Interaction History
The following problems may result in incorrect behavior for Interaction History:

■ Cannot create an interaction – mandatory parameters that must be validated.
To create an interaction, a valid party_id (customer), resource_id (agent),
outcome_id, and handler_id (application) are required. If any of these
parameters are invalid or missing, the create interaction APIs will fail.

■ Cannot create an interaction – optional parameters that must be validated.
To create an interaction, the following optional parameters must be valid:
result_id, reason_id, and campaign.

■ Cannot create an activity – mandatory parameters that must be validated.
To create an activity, a valid interaction_id, action_item (business activity type)
and outcome_id are required. If any of these parameters are invalid or missing,
the create activity APIs will fail.

■ Cannot create an activity – optional parameters that must be validated.
To create an activity, the following optional parameters must be valid: result_id,
reason_id, action_id (sub-level detail related to business activity), media_id,
task_id, cust_account_id, and campaign.

■ Cannot create a media item – mandatory parameters that must be validated.
To create a media item, a valid media item type and media data are required. If
any of these parameters are invalid or missing, the create interaction APIs will
fail.

■ Cannot create an interaction, activity, or media item – failure to load
mandatory parameter seed data.
It is impossible to create an interaction if one of the following tables does not
cannot seed data: outcomes and action items. These parameters must be
validated.

■ Cannot create an interaction, activity, or media item – failure to load optional
parameter seed data. It is impossible to create an interaction if one of the
following tables does not cannot seed data: results, reasons, and actions. It these
parameters are set, then they must be validated.

References
Oracle CRM Foundation Components - Interaction History High-Level Design Document

Oracle CRM Foundation Components - Concepts and Procedures, Release 11i, April 2000,
Part No. A83642-01
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Setting Profile Options
Setting Profile Options
Interaction History does not use profiles.

Workflows in Interaction History
Interaction History does not use Workflow processes.
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Implementing Fulfillment

This topic group provides general descriptions of the setup and configuration tasks
required to implement the application successfully. This section covers the
following topics:

■ Release Dependencies

■ Related Documentation and Resources

■ Setting Up a Fulfillment Administrative User

■ Assigning the JTF_FM_ADMIN Role to the Administrator

■ Assigning the JTF_FM_Administrator Responsibility to the Application
Administrator

■ Defining and Configuring the Fulfillment Server

■ Defining Resource Groups and Assigning Groups to Servers

■ Configuring Email Servers

■ Archiving Sent Emails

■ Configuring Fax Servers

■ Configuring File Servers

■ Configuring Printers

■ Creating Groups for Servers

■ Creating a New Template

■ Adding a Master Document to a Template

■ Inserting Collateral into a Template

■ Setting Up and Starting the Fulfillment Server
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Release Dependencies
■ Setting up Remote Command of the Fulfillment Server

■ Modifying Startup Scripts for Remote Commands

■ Sending Remote Commands through a Script File

■ System Profile Options

Release Dependencies
Before Fulfillment is installed, these items must be installed and stable:

■ CRM Foundation HTML Stack

■ Interaction History

■ Marketing Encyclopedia Foundation Component (MES)

Related Documentation and Resources
You may also wish to consult the following documentation:

■ Oracle Applications, Product Update Notes, Release 11i

■ Installing Oracle Applications, Release 11i

■ Implementing CRM Applications

■ Oracle CRM Foundation Components Concepts and Procedures

■ Oracle CRM Foundation Technical Reference Manual

■ Oracle Workflow Guide

These documents range from the general to the specific, in the order listed in the
following table.

Related Documentation

Document Purpose

Oracle Applications, Product Update Notes,
Release 11i

Contains information about new product features and
functions for the various Oracle applications

Installing Oracle Applications, Release 11i Documents the Rapid Install installation process
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Assigning the JTF_FM_ADMIN Role to the Administrator
Setting Up a Fulfillment Administrative User

The Foundation HTML Stack provides the interface for Fulfillment administration.
The following table describes the basic steps for setting up Fulfillment.

Assigning the JTF_FM_ADMIN Role to the Administrator
The JTF_FM_ADMIN role for the Fulfillment administrator has been pre-defined.
Perform the following steps to assign the role to the appropriate user.

Implementing CRM Applications, A85301-01 Contains post-installation information on CRM modules

Oracle CRM Foundation Components,
Concepts and Procedures

A printed compilation of the Oracle Foundation online help
system

Oracle CRM Foundation, Technical Reference
Manual

Contains table and view descriptions for all the Foundation
components

Step Required? Description Navigation Path

1 Yes Creating an administrative user.

■ Assign the JTF_FM_Admin role to the
application administrator user.

■ Assign the JTF_FM_Administrator
responsibility to the same user.

■ System Administrator:
Security > User

■ System Administrator:
Security > User > Define

2 Yes Identify the agents and the output devices you will
use with Fulfillment.

■ N/A

3 Yes Define the Fulfillment server(s). ■ Fulfillment Administrator:
Server

4 Yes Define the resource groups for each output device
and assign groups to servers.

■ Fulfillment Administrator:
Groups

5 Yes Adding a Master Document to a Template ■ Fulfillment Administrator:
Master Document > Upload

6 No Associate a Master document with template. ■ Fulfillment Administrator: >
Template > Master Document

7 Yes Set up and start the Fulfillment server. ■ Oracle Applications

Related Documentation

Document Purpose
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Assigning the JTF_FM_ADMIN Role to the Administrator
Prerequisites
The Fulfillment administrator must be defined as a user and have a password. The
administrator must have the JTF_FM_ADMINISTRATOR responsibility assignment.

Steps
1. Log in to the System Administrator Console as the system administrator.

2. Select the Users tab and click Create.

The User Registration window opens.

3. Enter the following required information:

■ First Name

■ Last Name

■ UserName

■ Password

■ Verify Password

■ E-mail

4. Use the drop-down list to select an account type:

■ An End user is an individual that is not representing an organization.

■ A Business user is an individual that is representing an organization.

5. Click Submit.

6. In the System Administrator Console, select the Users tab.

7. Enter the Last Name of the Fulfillment administrator in the Search field and
click Go.

8. In the user name column, click the user name.

The User Details window opens with the particular user’s details.

9. Click Roles.

The User Role Mapping window opens displaying two lists: Available Roles
and Assigned Roles.

10. Select the JTF_ADMIN role from the Available Roles list and click > to move it
to the Assigned Roles list.
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Assigning the JTF_FM_Administrator Responsibility to the Application Administrator
11. Click Update to complete the task of assigning the Administrator role to the
Fulfillment administrator.

Assigning the JTF_FM_Administrator Responsibility to the Application
Administrator

When Oracle CRM Applications are first installed, the sysadmin user is the only
defined user. The JTF_FM_Administrator responsibility has been predefined. You
must assign this responsibility to the user who is the administrator for Fulfillment.

You will need to know the responsibility_id and the application_id to perform this
task. To determine this information, log on to SQLPLUS using the apps user ID and
execute the commands listed in the following table.

Use the following procedure to assign the JTF_FM_Administrator responsibility to
the appropriate user.

Prerequisites
The Fulfillment administrator user must be a registered user with a password. See
Assigning the JTF_Admin Role to the Administrator.

Execute SQLPLUS commands to determine two values in your database:
responsibility_id for the jtf_fm_administrator key, and application_id for JTF.

Steps
1. Use Oracle Forms to login as the System Administrator and navigate to

Security > User > Define.

2. Enter the Fulfillment administrator’s user ID in the User Name field.

3. Enter the Fulfillment administrator’s password in the Password field.

4. Choose JTF_FM_ADMINISTRATOR from the Responsibility list of values
(LOV).

Necessary SQLPLUS Commands

Information Retrieval Command

responsibility_id SELECT RESPONSIBILITY_ID FROM FND_RESPONSIBILITY
WHERE RESPONSIBILITY_KEY = ’JTF_FM_ADMINISTRATOR’;

application_id SELECT APPLICATION_ID FROM FND_APPLICATION
WHERE APPLICATION__SHORT_NAME = ’JTF’;
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Defining and Configuring the Fulfillment Server
5. Select File > Save and Proceed, then close this window.

6. In the System Administrator window, navigate to Profile > System.

7. In the Find System Profiles window, select the User box and enter the
Fulfillment administrator’s user name.

8. In the Profile field, enter JTF% and click Find.

The System Profile Values window displays all the profiles that begin with JTF.
The Fulfillment administrator’s user name appears at the top of the User
column on the right.

9. Modify the following profiles by entering values in the User column:

■ JTF_PROFILE_DEFAULT_APPLICATION: enter the value of the
application_id used in your database

■ JTF_PROFILE_DEFAULT_RESPONSIBILITY: enter the value of the
responsibility_id used in your database

■ JTF_PROFILE_DEFAULT_LANG: enter US

10. Select File > Save and Proceed and return to the Find System Profiles window.

11. In the Profile LOV, enter ICX% and click Find.

12. Select ICX: LANGUAGE and set the language to your language.

13. Select File > Save.

The Fulfillment administrator now has been assigned the appropriate
responsibility.

Defining and Configuring the Fulfillment Server
The Fulfillment server calls on database tables to supply the Fulfillment collateral,
and sends the collateral to specified output devices. You need to configure the
Fulfillment server with specific output devices and associate the output devices
with specific agent groups.

When creating a new Fulfillment server, follow the procedures that are listed on the
window in the Servers column. The procedures are listed in sequence, from top to
bottom.

You must define the Time format as yyyy-MM-dd HH:mm:ss.S, where:

■ yyyy is the year in four digits
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Defining and Configuring the Fulfillment Server
■ MM is the month in two digits (06)

■ dd is the day in two digits (04)

(Enter a space between dd and HH)

■ HH is the hour, in two digits (from 01–24)

■ mm is the minutes in two digits

■ ss is the seconds in two digits

■ S is milliseconds in one digit

Prerequisites
None

Steps
1. Select the Server tab.

2. Click Create.

The General window opens.

3. Enter the Server Name and other information as necessary.

4. Enter the current date and the time of day that Fulfillment should begin
operations in the Start Time field. The Start time should occur after the date and
time that the server is created.

5. Enter a date and the time of day that Fulfillment should end operations in the
Shut Down Time field. The StartTime and Shut Down Time should not be
specified if the Fulfillment server runs 24 hours a day.

6. Enter a unique name for the Request Queue.

7. Enter a unique name for the Response Queue.

8. (Optional) Enter a description for the server.

9. Click Continue.

Once the Request Queue and the Response Queue are created, JTF_FM_ is
added to the front of the unique names you entered.

See Also
■ Configuring Email Servers
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Defining Resource Groups and Assigning Groups to Servers
■ Configuring File Servers

Defining Resource Groups and Assigning Groups to Servers
A resource group is a group of people. Each resource group must be assigned to a
Fulfillment server. Perform the following steps to define a group and assign it to a
server.

Prerequisites
A Fulfillment server must be defined and configured. Agents must be registered
users.

Steps
1. In the Fulfillment Administrator Console, select the Server tab and click Groups

> Create.

The Create Group window displays the fields you need to create a resource
group.

2. Enter the Group Name and Description. Select the appropriate Server from the
list.

3. In the list of Agents, click Go to begin a search of Agents.

The Select Agent window opens.

4. In the Select Agent window, enter the initial letter of the agent’s name with %
and click Search.

5. Click the agent name to add the agent to the group. Repeat steps 3 and 4 for
each of the agents you want to include in the group.

6. When the list of agents is complete, click Create.

Configuring Email Servers
The second step in configuring the Fulfillment server is to associate the email
servers with the Fulfillment server.

Prerequisites
You must have already created the server. To begin, see Defining and Configuring
the Fulfillment Server.
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Archiving Sent Emails
Steps
1. In the Email Servers window, choose the Add button to add a new email server.

The Create Email Server window opens.

2. In the fields on the Create Email Server window, enter the information required
to describe the email server that you are adding. In the Incoming and Outgoing
server fields, enter the IMAP or SMPT server names.

3. Click Save.

The Email Servers window appears.

4. To add more Email servers, repeat steps 1, 2, and 3.

Archiving Sent Emails
Every email message that gets created by the Java Mail API, used by the Fulfillment
server, has a message identifier (SMTP ID) associated with it. The message identifier
is retrieved and stored as part of an interaction activity in Interaction History. The
Fulfillment server will fetch SMTP ID for outgoing emails that are sent through
direct SMTP connection. The server makes a connection to the email server with a
login account.

The following information is required for the Fulfillment server to store emails on
an IMAP Server.

■ IMAP Server Name

■ IMAP User Id

■ IMAP Password

■ IMAP Folder Name

The extended header tag was designed for Fulfillment to be a simple name-value
pair consisting of header name and header value. The information of IMAP Server,
IMAP User Id, IMAP Password, and IMAP Folder is passed in as part of the
extended header as follows:

<extended_header>
<header_name>

IMAP Server
</header_name>
<header_value>

imap01.companyname.com
</header_value>
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Configuring Fax Servers
</extended_header>
<extended_header>
<header_name>

IMAP User Id
</header_name>
<header_value>

Scott
</header_value>
</extended_header>
<extended_header>
<header_name>

IMAP Password
</header_name>
<header_value>

Tiger
</header_value>
</extended_header>
<extended_header>
<header_name>

IMAP Folder
</header_name>
<header_value>

Sent Fulfillment
</header_value>
</extended_header>

For example, a Fulfillment request is created to email collateral to a customer.
Fulfillment sends the automated response and makes a copy of the email message
sent out for archiving in the sent folder. Fulfillment captures the SMTP ID of the
copy of the outgoing email message and creates a media item for the response and
inserts the SMTP ID in the MEDIA_ITEM_REF column. Fulfillment records the
interaction by creating the interaction history record and two corresponding
activities inbound email and outbound responses.

Configuring Fax Servers

WARNING: Windows relating to fax functionality or capability
are not supported at this time, and should not be used.
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Creating Groups for Servers
Configuring File Servers

Configuring Printers

Creating Groups for Servers
The last step in configuring the Fulfillment server is to associate agent groups with
the Fulfillment server, and associate output devices with the groups. By associating
a group to an output device, you indicate that the group will use that device. You
must create an association for each agent group to each output device for which the
group needs access. Perform the following steps to associate an agent group to one
or more output devices.

Prerequisites
You must have already created the Fulfillment server. See Define and Configure the
Fulfillment Servers.

Steps
1. To add a group, in the Groups window, choose the Add button.

The Select Group window opens.

2. From the Group Name drop-down list, choose a group to associate with the
Fulfillment server.

3. Choose Go.

WARNING: Windows relating to file server functionality or
capability are not supported at this time, and should not be used.

WARNING: Windows relating to print functionality or capability
are not supported at this time, and should not be used.

Note: When a group is associated to a Fulfillment server, that
server’s file server is automatically available for the group. You do
not need to associate a file server to a group or its agents.
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Creating a New Template
The Output Devices window opens to display a list of output device types.
Create an association with each output device to which the group needs access.

4. From the list of values (LOV) for one type of output device, choose one or more
devices to be associated to the group.

5. Click Create to create the association or click Clear to clear associations that you
have selected but have not yet created.

6. Repeat step 5 and 6 for each type of output device to be associated to the group.

7. Click Save to complete the association of the group to output devices.

See also
Creating New Groups

Adding Agents to a Group

Creating a New Template
A template is a pre-defined package of brochures, newsletters, or other
customer-oriented information that an agent can direct to customers in response to
a Fulfillment request. Text found in a template is associated to one or more master
documents.

Perform the following steps to create a new template.

Prerequisites
■ An uploaded Master Documents must exist.

■ Collateral must already be stored in the database.

Steps
1. Select the Template tab.

2. Click Create.

The General window opens.

3. Enter a Template Name.

4. In the Status drop-down list, choose either:

■ Active to make the template available to requests.

■ Inactive to make the template unavailable to requests.
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Inserting Collateral into a Template
5. (Optional) In the Description field you may enter a description of the template.

6. (Optional) Enter the name of the marketing campaign you want to associate
with the template.

7. Click Save.

The Template Master Document window opens.

See Also
Updating Fulfillment Templates

Adding a Master Document to a Template
Perform the following steps to add a master document to a template.

Prerequisites
The template must already exist. See Creating a New Template.

Steps
1. Choose the Template tab.

The View Template window opens.

2. Choose the name of the template that you want to add.

The template details window opens.

3. Choose the Master Document link in the left frame.

The View Template, Master Documents window opens.

4. Choose Go to add more master documents.

5. Choose Update to save.

Inserting Collateral into a Template
Perform the following steps to add collateral to a template.

Prerequisites
None
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Setting Up and Starting the Fulfillment Server
Steps
1. Choose the Template tab.

The View Template window opens.

2. Choose the name of the template that you want to update.

The template details window opens.

3. Choose the Collateral link in the left frame.

The View Template, Collateral window opens.

4. Click Go to add collateral.

5. Click Update to save.

Setting Up and Starting the Fulfillment Server
Perform the following steps to set up the server.

Prerequisites
You must be able to log on to the System Administration Console as
JTF_FM_ADMIN, or in a similar role, to perform the following steps.

Steps for creating a Fulfillment server using the SysAdmin Console
1. Log on the System Administration Console as an administrative user. (For

example, log on as JTF_FM_ADMIN.)

2. Select the Server tab.

3. Create a new Fulfillment server.

4. Note the ID number of the server.

Note: Perform the following procedure in either a UNIX or
Windows-NT environment.

Note: For details on this account, see Assigning the JTF_FM_
ADMIN Role to the Administrator, and Assigning the JTF_FM_
Administrator Responsibility to the Application Administrator.
52 Oracle CRM Application Foundation Implementation Guide



Setting Up and Starting the Fulfillment Server
This number is needed in the start-up script for the server. Usually, the first time
a server is created, it’s ID is 10000. After that, it increments by one with each
new server.

5. Create an e-mail server to associate with the Fulfillment server that was created
in step 3.

This is an email server associate mailed with the Fulfillment server, not any
other email server. This email server will need to have the outgoing email
server set.

For many UNIX environments, give the name of the UNIX box that is to run the
Fulfillment server. For example, this could be similar to
AP102SES.COMPANY.COM.

6. In the Group tab, create a group and associate a Fulfillment server to that
group. (This should preferably be the same one that was just created.)

7. Assign a user to that group.

The ID of the user, since you may be submitting requests with that user.

8. Return to the Server tab and find the server that you created in step 2.

9. Double-click the server name to open the general information window.

10. Select Groups at the left hand side of the window.

The Select Group window opens.

11. Associate the group you created with this server, and select Go.

The Output Devices window opens.

12. Associate an e-mail server with this server, and select Create.

13. Select Save.

14. Select the Template tab.

15. Click Master document.

16. Click Upload.

17. Follow the upload steps to upload master documents to the server.

Steps for setting up the shell or batch script
1. Modify the classpath so that it points to both apps.zip and 3rdparty.zip
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Setting Up and Starting the Fulfillment Server
2. Create a simple batch file, or UNIX shell script, from which the server can be
configured and executed.

Here is a batch file example:

java -ms32m -mx64m -nojit\ (for UNIX shell script, add exec to the beginning
of the line and trhere should not be any
carriage returns in the script.)

-Dengine.OutputDir=output\
-Dengine.CommandPromptEnabled=true\
-Dengine.ServerID=999\
-Dengine.AOLJ.config= d:\lib\jtf.dbc\
oracle.apps.jtf.fm.engine.processor.Processor\

Parameters

■ engine.OutputDir

This parameter specifies the output directory to be used by the Fulfillment
Dispatcher. Early versions of Fulfillment server may not have this feature.

■ engine.CommandPromptEnabled

This parameter must be set to true if you want to interact with the
Fulfillment server via the command prompt.

■ engine.ServerID

This parameter specifies the ID of the server.

■ engine.AOLJ.config

This parameter specifies the location of the jtf.dbc file that the server needs
to be able to communicate with the database.

■ engine.refreshrate

(Optional) This parameter specifies is the number of milliseconds between
the status checks that the processor performs.

■ engine.LogPath

This parameter specifies the location of the log files that the Fulfillment
server writes to. The default is a directory called log off of the directory
where the Fulfillment server is started.

■ engine.TempDir
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Setting Up and Starting the Fulfillment Server
This parameter specifies a temporary directory where the Fulfillment server
can swap files that would normally be too large when collectively stored in
memory. This value must be set in absence of the profile option JTF_FM_
TEMP_DIR. It can also be used to override the value of JTF_FM_TEMP_DIR

■ engine.EventLog

This parameter specifies an alternative name for the Events log. This value
may be set in the absence of the profile option JTF_FM_EVENTS_LOG. It
can also be used to override the value of JTF_FM_EVENTS_LOG. This
value will default to Events.log if not set at all.

■ engine.ErrorLog

This parameter specifies an alternative name for the Error log. This value
may be set in the absence of the profile option JTF_FM_ERROR_LOG. It can
also be used to override the value of JTF_FM_ERROR_LOG. This value will
default to Error.log if not set at all.

■ engine.LogLevel

This parameter specifies the level of detail recorded in the Error log. This
value may be set in the absence of the profile option JTF_FM_LOG_LEVEL.
It can also be used to override the value of JTF_FM_LOG_LEVEL. This
value will default to 4, the highest level of detail, if not set at all. The lowest
value of zero should never really be used since it means that no errors will
be recorded at all.

■ engine.LogRequests

This parameter is a Boolean property that can be used to specify that
Fulfillment Requests are to be saved before processing. The request will be
saved with the request id in the name. For request id 10010 the logged
request will be 10010.xml and can be found in the requests directory within
the log directory. This value is false by default.

■ engine.LogDispatches

■ This parameter is a Boolean property that can be used to specify that
Fulfillment Requests are to be saved after processing and before
dispatching. The request will be saved with the request id in the name. For
request id 10010 the logged request will be 10010.xml and can be found in
the dispatches directory within the log directory. This value is false by
default.

■ engine.FaxEnabler
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Setting up Remote Command of the Fulfillment Server
This parameter specifies is used to specify the name of the class that enables
fax requests to be fulfilled.

■ engine.PrintEnabler

This parameter specifies the name of the class that enables print requests to
be fulfilled.

3. Execute the batch file or UNIX shell script to start the Fulfillment server.

Guidelines: Use the following Fulfillment server commands:

■ stat: Prints statistics on the current state of the Fulfillment server.

■ stop: Stops the Fulfillment server. This command stops all processing
within the Fulfillment server. It can resume processing with the start
command.

■ start: Starts the Fulfillment server. Should only be executed after a stop
has been issued.

■ restart: stops and restarts the Fulfillment server. This is similar to a soft
reboot of a Personal Computer.

■ help: Displays all valid commands for the Fulfillment server.

Testing your setup
Test your server setup by submitting a request and verifying that it shows up as
successful in the logs.

Setting up Remote Command of the Fulfillment Server
The Fulfillment server has the ability to receive remote commands through a
command port. These remote commands are sent through a remote command script
that runs on the same machine as the running Fulfillment server you want to
command. This remote command script only runs on the same machine as the
running Fulfillment server you want to control. The script interacts with the server
without the need of maintaining the original command prompt used to start the
server.

When a command is sent through this script, the command is sent, a response is
waited for, and the script ends. A connection to the Fulfillment server is not
maintained between issued commands.
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Modifying Startup Scripts for Remote Commands
Prerequisites
You must be able to log on to the System Administration Console as
JTF_FM_ADMIN, or in a similar role, to perform the following steps.

Steps for Setting up a remote command script
For the purpose of sending commands to a running Fulfillment server, you create a
new script that will be executed every time a remote command. To create a script to
send commands to port 99999, the body of the script should appear as:

For UNIX:
#!/bin/csh
java –Dengine.CommandPort=99999 oracle.apps.jtf.fm.engine.remote.RemoteCommand
$*

For DOS:
java –Dengine.CommandPort=99999 oracle.apps.jtf.fm.engine.remote.RemoteCommand
%*

In both cases, the property engine.CommandPort must contain the numeric value of
an available port on the machine running the Fulfillment server.

Modifying Startup Scripts for Remote Commands

Prerequisites
Set up the Remote Command of the Fulfillment Server

Note: If you using an older version of the Fulfillment Server, you
may be using a version of the Fulfillment Server in which the
Remote Command class is found under
"oracle.apps.jtf.fm.engine.processor" package as in
"oracle.apps.jtf.fm.engine.processor.RemoteCommand" instead of
"oracle.apps.jtf.engine.remote.RemoteCommand". It is also possible
that the version of the server you are running predates the use of
remote commands in which case you need to update your version
with a patch.
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Sending Remote Commands through a Script File
Steps for Modifying the Startup Scripts
To set up the Fulfillment server so that it will listen to remote commands, add the
text -Dengine.CommandPort=##### to the Fulfillment server Startup Script. To
listen to port 99999 add the following text:

-Dengine.CommandPort=99999

Sending Remote Commands through a Script File

Prerequisites
Set up the Remote Command of the Fulfillment Server

Modify Startup Scripts

Create a Script file

Steps
Once you have created a script file (see Setting up a remote command script) you
can run it with any of the recognized Fulfillment server commands as follows:

[script name] [server command]

where [script name] is the name of the script file and [server command] is the
command you want to execute. Some of the commands received by the Server
issues a response such as with

stat

the command that gets the Server statistics. If you have a script named remote.script
and you want to run

stat

against a Fulfillment server that is listening to port 99999 for remote commands you
would type:

remote.script stat

Data appears at the command prompt just as if you were to type stat from the
Fulfillment servers’ command prompt. The following are the results of sending a
remote ‘stat’ command:

SENDING>stat
RESPONSE>-- PROCESSOR STATISTICS --
>--Memory Use: 599.39Kb of 32767.99Kb -- 1.83%
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System Profile Options
>PROCESS MONITOR : Monitor Started
>REMOTE MONITOR : Monitor Started
>COMMAND MONITOR : Monitor Started
>REQUEST MONITOR : Monitor Started
>#processes:5; running:5; idle:5; processing:0; dead:0
>Max Idle Time:14 seconds; 59 milliseconds
>Event Log:Events24.log
>Error Log:Errors24.log
>ACTIVE THREAD(S):11

System Profile Options
Use the following list to identify the profile options which need to be set for your
specific implementation. Set these profile options in any order.

■ JTF_FM_TEMP_DIR

■ JTF_FM_OUT_DIR

■ JTF_FM_EVENTS_LOG

■ JTF_FM_ERROR_LOG

■ JTF_FM_LOG_LEVEL

■ JTF_FM_NUM_PROCESSES

■ JTF_FM_MIN_PROCESSES

■ JTF_FM_MAX_PROCESSES

■ JTF_FM_PROCESS_IDLE

■ JTF_FM_MAX_PROCESS_IDLE

■ JTF_FM_REFRESH_RATE

To change profile options, use the standard procedure outlined in the Oracle
Applications Users Guide.

Profile Option JTF_FM_TEMP_DIR
The following table details JTF_FM_TEMP_DIR, which sets the temporary directory
for the Fulfillment engine. (This is not a full path.)

Required

User can Admin Setting Levels

View Update User Responsibility Application Site
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System Profile Options
Profile Option JTF_FM_OUT_DIR
The following table details JTF_FM_OUT_DIR, which sets the output directory for
the Fulfillment engine.

Profile Option JTF_FM_EVENTS_LOG
The following table details JTF_FM_EVENTS_LOG, which sets the events log name
for the Fulfillment engine.

Profile Option JTF_FM_ERROR_LOG
The following table details JTF_FM_ERROR_LOG, which sets the error log name for
the Fulfillment engine.

Profile Option JTF_FM_LOG_LEVEL
The following table details JTF_FM_LOG_LEVEL, which sets the level of logging
detail.

X X X X X

Required

User can Admin Setting Levels

View Update User Responsibility Application Site

X X X X X

Required

User can Admin Setting Levels

View Update User Responsibility Application Site

X X X X X

Required

User can Admin Setting Levels

View Update User Responsibility Application Site

X X X X X

Required

User can Admin Setting Levels

View Update User Responsibility Application Site

X X X X X
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Profile Option JTF_FM_NUM_PROCESSES
The following table details JTF_FM_NUM_PROCESSES, which sets the number of
engine processes at the start up of the Fulfillment engine.

Profile Option JTF_FM_MIN_PROCESSES
The following table details JTF_FM_MIN_PROCESSES, which sets the minimum
number of processes available at any given time in the Fulfillment engine.

Profile Option JTF_FM_MAX_PROCESSES
The following table details JTF_FM_MAX_PROCESSES, which sets the maximum
number of processes available at any given time in the Fulfillment engine.

Profile Option JTF_FM_PROCESS_IDLE
The following table details JTF_FM_PROCESS_IDLE, which defines the number of
milliseconds a process is allowed to remain idle before the processor starts reducing
to the minimum.

Required

User can Admin Setting Levels

View Update User Responsibility Application Site

X X X X X

Required

User can Admin Setting Levels

View Update User Responsibility Application Site

X X X X X

Required

User can Admin Setting Levels

View Update User Responsibility Application Site

X X X X X

Required

User can Admin Setting Levels

View Update User Responsibility Application Site

X X X X X
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Profile Option JTF_FM_MAX_PROCESS_IDLE
The following table details JTF_FM_MAX_PROCESS_IDLE, which defines the
maximum number of milliseconds a process is allowed to remain idle before the
processor starts reducing to the minimum.

Profile Option JTF_FM_REFRESH_RATE
The following table details JTF_FM_MAX_PROCESS_IDLE, which defines the
number of milliseconds a process is allowed to remain idle before needing a refresh.

Required

User can Admin Setting Levels

View Update User Responsibility Application Site

X X X X X

Required

User can Admin Setting Levels

View Update User Responsibility Application Site

X X X X X
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Implementing Assignment Manager

This topic group provides general descriptions of the setup and configuration tasks
required to implement the application successfully. This section covers the
following topics:

■ Related Documentation and Resources

■ Setting System Profile Options

Related Documentation and Resources
You may also wish to consult the following documentation:

■ Oracle Applications, Product Update Notes, Release 11i

■ Installing Oracle Applications, Release 11i

■ Implementing CRM Applications

■ Oracle CRM Foundation Components Concepts and Procedures

■ Oracle CRM Foundation Technical Reference Manual

■ Oracle Workflow Guide

These documents range from the general to the specific, in the order listed in the
following table.
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Setting System Profile Options
Setting System Profile Options
Use the following list to identify the profile options that you need to set for your
specific implementation. You can set these options in any sequence.

■ ACTIVATE_AUTO_SELECT

■ ACTIVATE_CONTRACTS_PREFERRED_ENGINEERS

■ ACTIVATE_IB_PREFERRED_ENGINEERS

■ ACTIVATE_WORKFLOW_NAME

To change profile options, use the standard procedure outlined in the Oracle
Applications Users Guide.

Profile Option ACTIVATE_AUTO_SELECT
The following table describes the profile option ACTIVATE_AUTO_SELECT, which
is set to activate the auto-selection of resources by the Assignment Manager engine.

The Assignment Manager engine uses this profile option setting to determine
whether the user needs to make a selection from the provided list of resources, or if
this task is performed automatically by the Assignment Manager engine itself.

Related Documentation

Document Purpose

Oracle Applications, Product Update Notes,
Release 11i

Contains information about new product features and
functions for the various Oracle applications

Installing Oracle Applications, Release 11i Documents the Rapid Install installation process

Implementing CRM Applications, A85301-01 Contains post-installation information on CRM modules

Oracle CRM Foundation Components,
Concepts and Procedures

A printed compilation of the Oracle Foundation online
help system

Oracle CRM Foundation, Technical Reference
Manual

Contains table and view descriptions for all the Foundation
components

Required

User can Admin Setting Levels

View Update User Responsibility Application Site

X X X X X X X

Setting Description and Usage Considerations
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Profile Option ACTIVATE_CONTRACTS_PREFERRED_ENGINEERS
The following table describes the profile option ACTIVATE_CONTRACTS_PREFERRED_
ENGINEERS, which is set to retrieve the preferred resource information from the Contracts
module.

The Assignment Manager engine uses this profile option setting to determine
whether the Contracts Preferred Engineers are picked automatically by the
Assignment Manager engine or not.

Profile Option ACTIVATE_IB_PREFERRED_ENGINEERS
The following table describes the profile option ACTIVATE_IB_PREFERRED_
ENGINEERS, which is set to retrieve the preferred resource information from the Installed
Base module.

The Assignment Manager engine uses this profile option setting to determine
whether the Installed Base Preferred Engineers are picked automatically by the
Assignment Manager engine or not.

Profile Option ACTIVATE_WORKFLOW_NAME
The following table describes the profile option ACTIVATE_WORKFLOW_NAME,
which is set to a user-defined workflow procedure name.

Y/N Default is Yes.

Required

User can Admin Setting Levels

View Update User Responsibility Application Site

X X X X X X X

Setting Description and Usage Considerations

Y/N Default is No.

Required

User can Admin Setting Levels

View Update User Responsibility Application Site

X X X X X X X

Setting Description and Usage Considerations

Y/N Default is No.
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This workflow procedure is user-programmed code for further filtering the
resources. The Assignment Manager engine retrieves the procedure name from this
profile option and uses it to process the user's request.

Required

User can Admin Setting Levels

View Update User Responsibility Application Site

X X X X X X X

Setting Description and Usage Considerations

None The name of a user-defined procedure.

There is no default. This is a user-defined procedure; it may or may not
exist.
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Implementing the Business Rule Monitor

This topic group provides general descriptions of the setup and configuration tasks
required to implement the module successfully.

The topics covered in this group include:

■ Related Documentation and Resources

■ Setting Up the Business Rule Monitor

■ Defining the Owner of the Workflow Process

■ Setting System Profile Options

■ Starting the Background Workflow Processes

■ Starting the Business Rule Monitor

■ Defining a Business Rule

■ Verifying Escalation Territory Creation

Related Documentation and Resources
You may also wish to consult the following documentation:

■ Oracle Applications, Product Update Notes, Release 11i

■ Installing Oracle Applications, Release 11i

■ Implementing CRM Applications

■ Oracle CRM Foundation Components, Concepts and Procedures

■ Oracle CRM Foundation Technical Reference Manual

■ Oracle Workflow Guide
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Setting Up The Business Rule Monitor
These documents range from the general to the specific, in the order listed in the
following table.

Setting Up The Business Rule Monitor
Oracle Escalation Manager provides two types of escalation management:

■ Reactive, or activity in response to a customer behavior

■ Proactive, or an automated response to a violation of business rules

A workflow process controls the Business Rule Monitor, which in turn periodically
checks the business rules that have been defined. The user that owns this workflow
process receives notifications when the process starts and stops, and also when
errors are detected. This user must be defined to ensure that an owner of the
workflow process exists and that the notifications can be sent successfully. Usually,
the workflow owner is the system administrator.

The Business Rule Monitor provides pre-defined business rules, which are detailed
in the table to follow. You may design your own rules that have been customized for
your enterprise.

Related Documentation

Document Purpose

Oracle Applications, Product Update Notes,
Release 11i

Contains information about new product features and
functions for the various Oracle applications

Installing Oracle Applications, Release 11i Documents the Rapid Install installation process

Implementing CRM Applications, A85301-01 Contains post-installation information on CRM modules

Oracle CRM Foundation Components,
Concepts and Procedures

A printed compilation of the Oracle Foundation online help
system

Oracle CRM Foundation, Technical Reference
Manual

Contains table and view descriptions for all the Foundation
components

Step Required? Steps to Implement Escalation Manager

1 Yes Define the owner of the workflow process.

2 Yes Set the Business Rule Monitor system profile option.

3 Yes Start the four background Business Rule Monitor workflow
processes

4 Yes Start the Business Rule Monitor.
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Setting System Profile Options
Defining the Owner of the Workflow Process
The owner of the workflow process is assigned to an existing user. This is typically
the system administrator or the workflow administrator.

Prerequisites
The designated workflow owner must already exist in order to assign the workflow
process. If no workflow owner exists, then the account must first be created.

Steps
1. In the System Administrator responsibility, navigate to Security > User >

Define.

The Users window opens.

2. Enter an existing user name in the Name field.

3. Enter a password in the Password field.

Do not press Enter to move to the next field, you must move your cursor.

4. Select the following responsibility from the LOV in the Responsibility field. This
grants the responsibilities to the user.

■ Workflow Administrator

5. Select File > Save.

Setting System Profile Options
Use the following procedure to set the system profile option: Business Rule Monitor
Workflow Administrator.

You can set these profile options in any order you like.

Prerequisites
None

5 Optional Define new, customized business rules.

6 Yes Verify that an Escalation Territory has been created and contains at
least one resource

Step Required? Steps to Implement Escalation Manager
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Starting the Background Workflow Processes
Steps
1. In the System Administrator responsibility, navigate to Profile > System.

The Find System Profile Values window opens.

2. Enter the following in the Profile field:

Business Rule Monitor Workflow Administrator

3. Click Find to open the System Profile Values window.

4. Enter the name of the workflow administrator in the Site field.

This user is the one that you previously named in Defining the Owner of the
Workflow Process.

5. Select File > Save.

Starting the Background Workflow Processes
There are four predefined workflow item types. The first item type, JTFBRM, is
internal to the Business Rule Monitor and has no user-defined attributes. The next
three item types have specific attributes defined for each process. These attributes
are maintained within the Business Rule Workbench, and can be viewed by clicking
the button next to the workflow field. The following table describes the preseeded
workflow processes.

Proper operation of the Business Rule Monitor requires that these four background
workflow processes be started before starting the Business Rule Monitor. Use the
following procedure to start these background processes.

Prerequisites
None

Preseeded Workflow Processes

Item Types Description

JTFBRM Business Rule Monitor Main Process

JTFBRMDF Business Rule Monitor Defect Process

JTFBRMPR Business Rule Monitor Task Process

JTFBRMSR Business Rule Monitor Service Request Process
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Starting the Background Workflow Processes
Steps
1. In the System Administrator responsibility, navigate to Requests > Run.

The Submit a New Request window opens.

2. Select Single Request and click OK.

3. In the Submit Requests window, type W in the Name field and press [Enter] on
the keyboard.

The Reports window opens and displays report names that begin with w.

4. Select Workflow Background Process and click OK.

The Parameters window opens.

5. Type bu in the Item Type field and press [Enter] on the keyboard.

The Item Type window opens and displays the four Workflow background
processes required by the Business Rule Monitor.

6. Select one of the four Business Rule Monitor processes and click OK.

Leave the Minimum Threshold and Maximum Threshold fields empty.

7. Enter Yes in the Process Deferred field, and in the Process Timeout field and
click OK.

The Submit Request window appears in front.

8. Click Schedule on the Submit Request window.

The Schedule window appears in front.

9. Select Run the Job...Periodically.

More options appear for defining the time period.

10. Define the Start time and the End time.

11. In the Rerun Every fields, enter the number of minutes that defines the interval
between job runs.

12. Select the From the Completion of the prior run box and click OK.

WARNING: Be sure to define an end time. When the end time
field is blank, the process runs indefinitely and cannot be shut
off.
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Starting the Business Rule Monitor
13. Repeat this entire procedure for each of the four workflow background
processes.

Guidelines
Set up Notifications in Oracle Workflow to ensure that notifications are sent to
e-mail.

Starting the Business Rule Monitor
The Business Rule Monitor monitors the workflow processes. In the Business Rule
Monitor, you must indicate how often the monitor checks the rules. Once the
Business Rule Monitor is started, there is no need to start it again, even after
defining new business rules. Use this procedure to start the Business Rule Monitor.

See also
Starting the Background Workflow Processes.

Prerequisites
The four Workflow background processes for the Business Rule Monitor must be
started before starting the Business Rule Monitor. If you have designed customized
workflow background processes, they must also be started. In addition, the Business
Rule Monitor Administrator profile option must be set.

Steps
1. In the CRM Administrator responsibility, navigate to Business Rule Monitor >

Business Rule Monitor.

The Business Rule Monitor opens.

2. Enter the time period in the Interval field. Enter a time unit (minutes or hours)
in the UOM field.

3. Click Save.

4. Click Start to activate the Business Rule Monitor.

A dialog box confirms that the Business Rule Monitor started successfully.

Click Workflow Monitor to view details of this process.

Guidelines
After the monitor is started, the Stop button appears. Click Stop to stop the monitor.
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Defining a Business Rule
Click Refresh Status to get an immediate status on the Workflow background
processes.

Defining a Business Rule
In addition to the pre-defined business rules provided with the Business Rule
Monitor, you can define your own business rules. Use the following procedure to
define a business rule.

Prerequisites
None

Steps
1. In the CRM Administrator responsibility, navigate to Business Rule Monitor >

Business Rules Monitor Workbench.

The Business Rules Monitor Workbench window opens.

2. Enter values for the following:

■ Name: The name of the new business rule

■ Object: The type of business rule

■ Check Rule Every: The time interval that you want

■ Workflow: Chose a workflow from the drop down menu.

Attributes can be defined for the Workflow and an Owner for the business rule.

3. Use the fields in the Simple tab to construct a PL/SQL statement that defines
the conditions under which the business rule is triggered.

4. Click Validate to check the syntax of the PL/SQL statement defined in the
Simple tab. The syntax check verifies whether or not the syntax is correct.

A dialog box confirms that the syntax validation was successful. Click OK.

Click Generate. A dialog box confirms that your business rule has been
generated.

5. Select File > Save.
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Verifying Escalation Territory Creation
Verifying Escalation Territory Creation
An escalation territory is a placeholder for resources that you want to put into
service under certain conditions. Escalation territories are defined in Territory
Management. Ensure that at least one resource is identified in the Catch All
Escalation Territory.

See also
View the following topics in Territory Manager for additional information:

■ Basic Territory Building Blocks

■ Viewing Escalation Territories

■ Creating Escalation Territories
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Implementing Dynamic Tables

This topic group provides general descriptions of the setup and configuration tasks
required to implement the spreadtable successfully.

Creating a New Dynamic Table
Use the Spreadtable Meta Data Administration window to design spreadtables that
plug into an Oracle Forms bean area container.

■ A spreadtable is the user interface component that contains rows, columns, and
column headers set in a grid that can be embedded into an Oracle form.

■ Oracle Forms-based CRM modules use the spreadtable to display and format
dynamically retrieved data at run time. This is accomplished by predefined
metadata definitions.

■ Metadata is information that defines what data is retrieved at run time and how
that information is presented.

The following table describes the Speadtable Meta Data Administration tabs.

Tab Description

Database Use to set column type and order, datatype, sequence, and default sort order.

Display Use to set column label, visibility, display sequence, and display width.

Alignment and Formatting Use to set type of header and cell alignment, as well as display type and format.

Custom Format Masks and
Mappings

Use to set how data displays. This applies only to columns with datatype of
Number. For example, it would display the values as a percent.
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Creating a New Dynamic Table
Perform the following steps to create a new spreadtable.

Prerequisites
None

Steps
1. In the CRM Administrator responsibility, navigate to Spreadtable

Administration.

The Spreadtable Meta Data Administration window opens.

2. Define a new datasource (a set of metadata) by entering the following:

■ Datasource Name: The unique name that identifies a set a metadata. It
must always be <Application Prefix>_<Name>.

■ Application: The name of your product.

■ Title: A descriptive name for this set of metadata.

Query Used exclusively by Universal Work Queue. It is for internal use only.

Sort Order Use to set the overall sort order of the columns for the spreadtable. For example,
you may set the primary sort order to be alphabetical based on column A, and set
a secondary sort order to be numerical based on column B.

Test Use to test the spreadtable that you are defining.

WARNING: Note the following:

Oracle does not support custom development of new forms using the
spreadtable interface.

Do not delete currently existing columns when modifying an existing
spreadtable. Instead, use the Freeze Visible State property in the Display
tab to make the column invisible to the user.

Do not delete any existing metadata definitions.

If you modify existing metadata definitions, these changes may be
overwritten by subsequent patches.

Tab Description
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Creating a New Dynamic Table
■ Relational View Name: Select from the LOVs the name of the view from
which information is to be retrieved to populate the spreadtable.

■ Lines/Rows: Enter how many lines of text are to display per row.

■ WHERE Clause: (Optional) Enter a SQL statement here if desired. Use this
field to enter filtering criteria. NEVER start with the keyword WHERE, as
this is automatically prepended to the statement. Always use bindvariables
if the value changes at runtime.

3. Select the Database tab, if it is not already selected, and enter the following for
each column that you wish to display in the spreadtable:

■ Column Alias: The column alias becomes part of the primary key.

■ View Column/ Function: Select from the LOVs the desired name of the
View Column.

■ Datatype: Select from the LOVs either character, number, or date.

■ Query Sequence: The sequence value determines the order in which
columns are extracted from the database. You could start with 1, but in
actual practice, it is a good idea to leave gaps in the sequence for ease of
row insertion later. To improve performance, begin with the columns that
you will refer to in your code, typically the primary key columns to execute
a query in a detail block.

■ Sortable: Selecting this box allows the user to sort on this column.

■ Default Sort Order: Sort in ascending or descending default order.

4. Select the Display tab, and enter the following for each column that you defined
previously:

■ Visible: Select to make this column visible in the spreadtable.

■ Freeze Visible Property: Select if you want the end user to be able to
change the visible properties (show/hide) at run time for this column.

■ Display Sequence: The value determines the order in which the columns
display in the spreadtable.

■ Display Width: Sets the width (in pixels) of the displayed column. This
value depends on the data that is displayed in the column.

■ The Column Alias and Label fields are supplied automatically. However,
you may change these values, if desired.

5. Select the Alignment and Formatting tab, and enter the following:
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Creating a New Dynamic Table
■ Header Alignment: Select from the LOVs either Center, End, Right, or Start.

■ Cell Alignment: Select from the LOVs either Center, End, Right, or Start.

■ Display Type: Select from the LOVs either check box, Hyperlink, or Text.

■ Display Format: (Optional) Select from the LOVs either Currency, Date, or
Date Time.

6. Select the Custom Format Masks and Mappings tab.

■ Column Alias: The column alias field is filled automatically.

■ Check box Mappings: These options apply only if the display type field in
the Alignments and Formatting tab is set to check box.

* Checked: Sets whether or not a column value is represented as a
checked check box or as its corresponding image.

* Unchecked: Sets whether or not a column value is represented as an
unchecked check box or as its corresponding image.

* Other: Sets how values other than those specified as either checked or
unchecked are represented.

■ Format Mask: Use to set how columns with datatype Number display data. For
example, it would display the values as a percent. Use this only in rare cases.

■ Currency Column: Points to the database view column where the currency
code for the current column is stored. This applies only if the display format
is set to Currency.

7. Select the Sort Order tab, and perform the following:

■ Choose the Primary Sort key from the LOVs.

■ You can optionally select a second or third Sort key from the LOV.

8. Click the Save icon on the toolbar. (The icon looks like a floppy disk.)

9. Select the Test tab, and click Test.

Your table displays. Refer to Using Dynamic Tables for additional information

on spreadtables.
78 Oracle CRM Application Foundation Implementation Guide



Administering Gantt

This topic group provides task-based procedures relating to the set up and
configuration of the TCF (Thin Client Framework) servers, used with Gantt charts.

This section covers the following topics:

■ What is a Gantt Chart?

■ What is TCF?

■ Implementing the TCF Servers for Gantt

■ Step1: Installing Any Required Patches

■ Step 2: Performing the Post Install Steps

■ Step 3: Configuring the Servers

■ Step 4: Verifying Server Configuration

What is a Gantt Chart?
A Gantt chart displays tasks or some other time bound entities in relation to their
owner/assignees. As such it is typically used for scheduling purposes, where a
manager can view the teams current workload and make real time decisions on
who should be assigned a new task, or alternatively make adjustments and reassign
tasks between members of the team.

Gantt charts are used by the following CRM modules:

■ Field Service Control Tower

■ Assignment Manager

The Gantt chart is designed as a Java Bean that can be plugged into any Oracle
Forms based application.
Administering Gantt 79



What is TCF?
What is TCF?
TCF is the acronym for Thin Client Framework. The Thin Client Framework server
is a middle tier process that enables certain Java components of the Oracle
Applications user interface to communicate with the middle tier and database tier.
Within CRM, these components are:

■ Field Service Scheduler

■ JTF Gantt Chart

The TCF server process should always be running in a production installation.

The SocketServer Class
The TCF server uses the SocketServer class (in the oracle.apps.fnd.tcf package) to
handle incoming connections. Administration of the TCF server is typically handled
through the ServerControl class (in the same package), which basically provides a
clean interface around all the different TCF server functions that an administrator
might perform (for example, starting, stopping, updating, and other similar tasks).

Oracle recommends using the ServerControl class for most purposes.

Proxy Objects and Dispatchers

TCF comprises the following:

■ A pair of Dispatcher classes which own the network connection

■ An interface called Proxy which enables an object to use the TCF network
connection.

■ An Item class which serializes data for transmission

Generally, the client application or applet creates a number of Proxy objects at the
same time, then asks the Dispatchers to connect these objects to peer objects on the
middle tier.

■ Proxies are implemented in pairs, one for the client, one for the middle tier.

Caution: The order and list of parameters for the ServerControl
class, and the SocketServer class are not the same. Refer to the
Administering the TCF Server (11i) documentation for a complete list.
You can access this document on Metalink (Note 123689.1).
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Step 1: Installing any Required Patches
■ The Dispatchers maintain a list of connected proxy pairs and handles the
routing of messages.

■ Proxies communicate by writing messages to a buffer maintained by a
Dispatcher, and then instructing the Dispatcher to send these messages.

■ Several proxies can share a round trip by waiting to call "send" until after each
has had an opportunity to write its messages.

■ The Dispatchers deliver these messages by invoking the readItem method of
Proxy.

Implementing the TCF Servers for Gantt
Gantt charts are used extensively by the various modules of the Oracle E-Business
Suite. However, for a Gantt chart to display and render properly, the TCF server
must be running and correctly configured.

The following tables lists the configuration steps that you must perform in setting
up and configuring the TCF server.

Step 5, troubleshooting problems that might arise with the TCF server configuration
and setup is covered extensively in the Troubleshooting Gantt section.

Step 1: Installing any Required Patches
The first step in setting up and configuring the TCF server is to install any patches
that are necessary for the correct performance of your particular system.

TCF Configuration Steps

Step Description

1. Apply any necessary patches.

2. Perform the post-install steps.

3. Configure the servers.

4. Verify the server configuration.

5. Troubleshoot any problems that arise.
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Step 2: Performing the Post Install Steps
Patch 135908
You must apply patch 135908 if you have set up the Oracle Applications to use
HTTP protocol for communicating between a client browser and Oracle Forms and
TCF servers.

135908 HTTP mode fails with: "java.io.IOException: Invalid HTTP Packet
received" when using TCF APIs.

Patch 1473057
You must apply patch 1473067 if you created the database using a non-US7ASCII
and non-WE8ISO8859P1 character set.

1473057 NLS enabled JDBC drivers. This is required for non-US7ASCII and
non-WE8ISO8859P1 character sets.

Step 2: Performing the Post Install Steps
There are several post install steps that you need to perform after installing the
patches listed in Step 1: Installing any Required Patches. These steps are described
in this section.

Post Install Steps
The patches described in section Step 1: Installing any Required Patches contain
both client and midtier Java code. After applying any of these patches, perform the
following steps:

1. Stop and start the TCF server. The TCF server does not pick up the latest code
until it is bounced.

2. Close the browsers on the client machines.

3. Clear out the JInitiator jcache directory on the client machines.

4. Restart the client browsers. You must do this to force the regenerated jar files to
be downloaded after you apply the patch.

Caution: If you have installed the TCF server on an IBM AIX
machine, then you must perform the steps listed in the AIX Port
Instructions section.
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Step 3: Configuring the Servers
AIX Port Instructions
If the TCF server is installed on an IBM AIX machine, then you must also do the
following:

1. Perform the port specific instructions provided in the JDBC 8.1.6 Release notes.
These Release Notes can be found on Metalink, note 114464.1.

In addition to the environment variables specified in the JDBC release notes,
you must update adovars.env with the following environment variable:

<JAVA_COMPILER>

and have it set to

<NONE>

If you omit this step, then you will encounter the problem described in bug
1510941 which causes the Gantt chart to fail.

2. Shut down the TCF server and restart it to force these changes to take effect.

Step 3: Configuring the Servers

In order for the TCF server and client to establish a connection over the network,
you should set up the following using the same communication protocol.

■ Forms servers

■ File appsweb.cfg

■ TCF servers

The following table lists the valid communication protocols that you can use in
setting up and starting the Forms and TCF servers.

WARNING: Setting the communication protocol correctly is
extremely critical. If this step is performed incorrectly, the
client/server communication will not work.

Communication Protocols

Forms Mode TCF Protocol

http HTTP
Administering Gantt 83



Step 3: Configuring the Servers
Forms Servers
When you start the Forms server from the command line (on UNIX), you must
include the Forms "mode" argument:

f60ctl { start | stop } port=port_num pool=pool_num log=log_file
mode={http|https|socket} exe=exe_name

Valid Forms modes are:

■ http

■ https

■ socket

File appsweb.cfg
Modify the appsweb.cfg file (usually found under $APPL_TOP/html/bin) so that it
includes the following:

connectMode=<protocol>

The connect mode parameter must indicate the same protocol as that which you set
for the Forms server. Again, valid protocols are:

■ http

■ https

■ socket

TCF Servers
Configure the TCF servers to start and run in the same communication protocol
mode as that which you set for the Forms servers and indicated in the appsweb.cfg
file.

https SSL

socket SOCKETS

Communication Protocols

Forms Mode TCF Protocol
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Step 4: Verifying the Server Configurations
Configuring the TCF Server Protocol
For details on configuring TCF servers, refer to the Administering the TCF Server (11i)
documentation for a complete list of the configuration settings. You can access this
document on Metalink (Note 123689.1).

Starting the TCF Servers

Start the TCF server from the command line (on UNIX) using the following
arguments:

jre oracle.apps.fnd.tcf.ServerControl [START|STOP|STATUS|UPDATE]
<portnumber|default=10021> [<param=value>]

Valid parameters are listed and described in the previously mentioned
Administering the TCF Server (11i) documentation.

Note the following:

1. Oracle strongly recommends that you start the TCF server with the PROTOCOL
parameter set to the same value that you set for the Forms mode argument, as
described in the Forms Servers section.

2. The DBC file parameter is required.

3. At server start up, the TCF:HOST and TCF:PORT profile options are updated
with the information passed into ServerControl.

a. If the TCF server is started using HTTP protocol, then the TCF:HOST
profile is prefixed with "http://".

b. If the TCF server is started using SOCKETS protocol, then the TCF:HOST
profile is set without the "http://" prefix.

Step 4: Verifying the Server Configurations
The following table lists the steps involved in verifying that the servers are
configured correctly.

Note: Oracle Applications provides a script that you can use to
start and stop a TCF server. Refer to the Installing Oracle Applications
guide, section "Review Server Process Control Scripts" for the name
and location of this file.
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Step 4: Verifying the Server Configurations
Each of these steps is described in detail in the following sections.

Step 4a: Verify Mandatory Setups
Verify that you have correctly performed all the steps listed in the previous sections:

■ Step 1: Installing any Required Patches

■ Step 2: Performing the Post Install Steps

■ Step 3: Configuring the Servers

If necessary, repeat any steps that were not performed correctly.

Step 4b: Verify TCF Host Name and Port Number
Perform the following steps to verify that the TCF host name and port number have
been set correctly.

1. Log in to your Personal Home Page (PHP) and select the Application Developer
responsibility.

2. In the Navigator, select Application > Menu.

The Menus window opens.

3. Select Diagnostics > Examine from the Help menu.

A password protect dialog box opens. Enter a valid password. If necessary,
contact your system administrator for a valid password.

After the password is authenticated, the Examine Field and Variable Values
window opens.

4. Enter the following search parameters:

■ Block: $PROFILES$

Steps to Verify Server Configuration

Step Action

❏ 4a. Verify that the mandatory setup steps were performed correctly.

❏ 4b. Verify the TCF Host Name and Port Number.

❏ 4c. Verify the TCF Connection

❏ 4d. Verify that Resources Exist in the System.

❏ 4e. Verify that the Assignment Manager is set up correctly.
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Step 4: Verifying the Server Configurations
■ Field: TCF:HOST

The Value field should now display the host name of the TCF server.

a. If the TCF server is started using HTTP protocol, then the host name must
be prefixed with "http://." If this is not the case, then one of the following
has occurred:

– The TCF server was not started in HTTP mode.

– The SocketServer class was used instead of ServerControl class to start
the TCF server.

– The system level TCF:HOST profile has been overridden at the
application or user level.

– The system level TCF:HOST profile has been manually changed on the
system level.

b. If the TCF server is started using the SOCKETS protocol, then the host
name must not be prefixed with "http://."

If the ServerControl class (not the SocketServer class) is used to start the TCF
server, then it automatically sets the system level profile options. These profile
option values can also be set manually at the system/application/user level in
Forms through the Profile menu, using the System Administrator responsibility.

Exercise extreme caution if you manually change these values. Setting these
values incorrectly may cause the Oracle Applications client code to not be able
to establish a connection to the TCF server.

5. Perform a new search, changing the value of Field to TCF:PORT.

The Value field should reflect the number of the port on which the TCF was
started.

Step 4c: Verify the TCF Connection
Using the Menu Tree Viewer, perform the following steps to verify that the TCF
connection is working properly:

1. Log in to your Personal Home Page (PHP), if you are not already there, and
select the Application Developer responsibility.

2. Select Application -> Menu.

3. Query up the JTF_NAVIGATE Menu item.

a. Select View > Query by Example > Enter.
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Step 4: Verifying the Server Configurations
b. Enter JTF_NAVIGATE in the Menu field.

c. Select View > Query by Example > Run.

The Menus window populates with information.

4. Click View Tree.

You should see a tree like structure that corresponds to the Navigator hierarchy
for the CRM Administrator responsibility.

For information on TCF connection problems, see Can Not Connect to the TCF
Server in the Troubleshooting Gantt section.

Step 4d: Verify Resources Exist
Perform the following to verify that resources are available in the system.

Log in as the APPS user using SQL*Plus and run the following SQL statement. This
will return the resources you can use to query up in the Assignment Manager:
Unassisted Mode:

SELECT jtf_task_utl.get_owner(r.resource_type ,r.resource_id)
resource_name
,r.resource_id
,r.resource_type
,o.name -- This is a descriptive name of the resource type

FROM ( select resource_id
,decode(category,'EMPLOYEE','RS_EMPLOYEE'
,'PARTNER','RS_PARTNER'
,'SUPPLIER_CONTACT','RS_SUPPLIER'
,'PARTY','RS_PARTY'
,'OTHER','RS_OTHER') resource_type

FROM jtf_rs_resource_extns) r
,jtf_objects_vl o
,jtf_object_usages u

WHERE r.resource_type = o.object_code
AND o.object_code = u.object_code
AND u.object_user_code = 'RESOURCES';

Note: Refer to the Oracle CRM Application Foundation Concepts and
Procedures, and the Oracle CRM Application Foundation
Implementation Guide for details on setting up and configuring the
Resource Manager.
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Step 4: Verifying the Server Configurations
The result of running this query is a list of the defined resources that you can use to
verify that the Gantt chart is set up correctly.

Step 4e: Verify the Assignment Manager Setup
Perform the following steps to verify that all the installation and setup steps for the
Oracle CRM Application Foundation Assignment Manager have been performed
correctly.

1. Log in to your Personal Home Page (PHP) and select the CRM Administrator
responsibility.

2. In the Navigator menu, select Task and Escalation Manager -> Manage
Escalations.

3. Enter anything into the Escalation Summary field.

4. Click Assign.

The Assignment Manager window opens.

5. Ensure that the Unassisted radio button is selected.

6. In the Resource Partial Name field, enter the first few letters from one of the
names returned by the SQL statement in the previous section (Verify Resources
Exist) and suffix the name with a percent "%" character.

7. Click Search.

■ If the Gantt and TCF servers are working and have been set up properly,
then you will see the resource name at the left side of the Gantt chart. If the
Calendar is defined correctly, then you may also see Shifts (yellow
background color) and Tasks (blue and red bars).

For a task to be visible, it must have been previously created, and have a
scheduled start/end date that falls within the visible time range, and be
assigned to a resource.

Note: Refer to the Oracle CRM Application Foundation Concepts and
Procedures, and the Oracle CRM Application Foundation
Implementation Guide for details on setting up and configuring the
Assignment Manager.
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Step 4: Verifying the Server Configurations
■ If an "APP-JTF-210807: No Resources Found. Please Try Again." message is
returned, then you have entered a name that does not exist, or alternatively
there may be a problem in Assignment Manager.

■ If nothing is returned, check the JInitiator Console Window for exceptions.
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Troubleshooting Gantt

This topic group provides information on common setup and configuration
problems associated with the Gantt chart, and information on how to resolve these
issues.

This section covers the following topics:

■ Common Issues

■ General Advice

■ Gantt chart Does Not Appear

■ Can Not Connect to TCF Server

■ No Resources are Visible

Common Issues
In general, problems with the configuration and setup of the Gantt chart fall into the
following categories. They are:

■ Gantt chart does not appear

■ Can not connect to TCF Server

■ No resources are visible

Resolution
If you are experiencing problems with the Gantt chart, then do the following:

1. First perform the steps listed under General Advice.

2. If this does not clear up the problem, then see the individual sections for the
listed problems.
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General Advice
General Advice
The following items are general suggestions to follow in troubleshooting problems
relating to the Gantt chart.

1. Clear out the JInitiator jcache directory, close and restart the browser, and try
again. Old, cached JAR files may be causing the problem.

2. Shut down and restart the TCF server. If a patch has been applied, then the new
code is not picked up by the runtime engine until the TCF server is restarted.

3. Check the JInitiator Console Window for exceptions or informational messages.
You can activate the Console Window by selecting the “Show Console” check
box in the JInitiator Control Panel. You must then close and restart the browser.

4. Ensure that there are no invalid objects in the database. You can use the adadmin
utility for this purpose.

5. If an invalid object is found, correct the problem, then make sure that the
offending form is recompiled (along with its libraries). This can be done also
through the adadmin utility.

6. If problems continue, then perform the steps listed in the following sections as
appropriate:

■ Gantt Chart Does Not Appear

■ Can Not Connect to TCF Server

■ No Resources Are Visible

Gantt Chart Does Not Appear
One of the most common problems is that a Form does not display the Gantt chart
properly. This can be in the form of one, or both, of the following symptoms:

1. The Form displays an empty blue or gray area where the Gantt chart should
reside.

2. The JInitiator “Console” Window throws a ClassNotFoundException, referring
to classes in oracle.apps.jtf.gantt.

Causes
The following are some of the possible causes for this condition:

1. jtfgantt.jar has not been downloaded onto the client machine. The JInitiator
console window must include a line similar to the following:
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Gantt Chart Does Not Appear
Opening http://<serverHost>/OA_JAVA/oracle/apps/jtf/jar/jtfgantt.jar no
proxy

It should not read:

Unable to contact http://<serverHost>/OA_JAVA/<some path>/jtfgantt.jar

2. Class files are missing from jtfgantt.jar or fndlist.jar.

3. An old version of jtfgantt.jar resides in the JInitiator jcache directory.

4. appsweb.cfg has been customized and does not include an entry for /OA_
JAVA/oracle/apps/jtf/jar/jtfgantt.jar.

5. The appsbase.html file, or the HTML page used to launch applications, has
been customized and does not pick up the archive tag from appsweb.cfg.

Actions to Take
1. Clear out the JInitiator jcache directory on the client and restart browser.

2. Verify that jtfgantt.lst is included in fndlist.jar.

a. First take a copy of fndlist.jar, then rename it to fndlist.zip, and use Win Zip
to open the file.

b. Verify that jtfgantt.lst in fndlist.jar lists approximately 26 class files.

3. Perform the actions described in step 2, but for jtfgantt.jar and verify that it
contains the files listed in jtfgantt.lst.

4. Ensure that the JInitiator console window does not list any class files as being
individually downloaded.

If this is the case something is wrong in the installation. Class files should be
downloaded within JAR files and nowhere else.

5. If Actions 2 through 5 do not verify properly, then perform the following
additional actions:

a. Force the regeneration of the FND and JTF JAR files through the adadmin
utility.

b. Restart the Forms (web) listener and the Forms server. Clear out the
JInitiator cache directory, and restart the browser.

c. Try Actions 2 through 5 again.

6. Critical! Ensure that all high priority FND (AOL) patches as listed in Metalink
have been applied.
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7. For the items listed as 4 and 5 under Causes in this section, launch the
applications. In Netscape Navigator, select "View Source" and verify that /OA_
JAVA/oracle/apps/jtf/jar/jtfgantt.jar is included in the archive tag.

If it is not included, then add the entry to files appsweb.cfg and appsbase.html.

Cannot Connect to TCF Server

There are several different errors that one might encounter when attempting to
connect to the TCF server, and several different reasons each error might occur.

However, in general, there are three basic types of errors that can affect server
connection:

■ The client application is unable to connect to the TCF server.

■ The TCF server is unable to connect to the database.

■ The application hangs upon connecting to the TCF server.

Each type of error is discussed in the following sections.

Unable to Connect to the TCF Server
The standard error message for this is:

"The application was unable to establish a network connection with the TCF
SocketServer listening on port: <port> on host: <host>. Please contact your
system administrator."

The exact message may vary slightly between versions and products.

You may also see the following:

"Unable to connect to dispatcher."

Things to check:

Note: If you are unable to establish a TCF connection, then there
may be a generic TCF setup problem. Contact your System
Administrator or Oracle Support representative to resolve the issue.
Until this issue is resolved, Gantt will not work properly.

The Menu and View Tree forms are owned by the Oracle
Application Object Library (AOL). It may be that this is an issue
that needs to be resolved within that context.
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■ Was the TCF server ever started?

The system administrator should be able to check if the process is running.

■ What host and port names were used to start the server?

Make sure that the profiles TCF:HOST and TCF:PORT on the client point to the
TCF server to which you are trying to connect. The best way to check them is to
use the Help > Diagnostics > Examine utility to check profiles just before
launching the TCF application. Make sure that you check the user-level profiles,
also, not just the site-level profile options. See Step 4b: Verify the TCF Host Name
and Port Number for details of this process.

■ Is the TCF server host machine accessible from the client?

Try to TELNET to the host to see if it is reachable.

Unable to Connect to the Database
The standard error message for this is:

"The TCF SocketServer running at <host>:<port> was unable to make a JDBC
connection to database <dbname>. This may reflect heavy load on the system, or
a problem with the indicated database. If this problem persists, please contact
your system administrator."

You may also see the following:

"Unable to set context."

Things to check:

■ Is there a ClassNotFoundException or OutOfMemoryError raised?

Check the server logs to see if either of these errors occurred. Sometimes a
ClassNotFoundException or a OutOfMemoryError is raised while the server is
attempting to connect will result in this error. The former are usually
configuration issues, the latter suggests that you might want to start your TCF
server with more memory.

■ Is the database actually up?

Try connecting from SQL*Plus to verify.

■ Are you connecting using DBC files?

For release 11.5 versions and above, it is now required that DBC files be used to
connect to the database. The TCF server must be started with a new argument
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"DBC=", pointing to a .dbc file that should be located under $FND_TOP/secure.
This command should read:

jre oracle.apps.fnd.tcf.SocketServer <port#> DBC=$FND_TOP/secure/xxx.dbc

It's important that the path to the .dbc file be specified. Because the TCF server
can connect to multiple databases, it doesn't depend on the specific .dbc file you
pass in, rather it relies on the path where those .dbc files are located to look up
multiple .dbc files.

If the TCF server is not started with the DBC argument or it cannot find the .dbc
file in the specified directory, this type of error might occur. Remember that the
TCF server may be looking for a different .dbc file than that with which you
started it. Check the server logs and see if it reports any errors while trying to
load the .dbc file.

■ Are the DBC files properly formatted?

A similar type of error can also occur if the .dbc file was improperly formatted.

A very common error to see on the server when this happens is:

ld.so.1: ... libocijdbc8.so: open failed: No such file or directory
(libocijdbc8.so)

This indicates that the server is attempting to use the THICK JDBC drivers to
the database, which is not supported. You need to make sure the .dbc file
specifies that the THIN drivers be used. The .dbc should contain the line:

APPS_JDBC_DRIVER_TYPE=THIN

The .dbc file also needs to contain the following variables that identify the
database to use:

DB_HOST=
DB_PORT=
DB_NAME=

These variables correspond to the database information in the tnsnames files.
The THIN drivers cannot use the TWO_TASK to resolve the database name,
you must provide this information explicitly. (The DB_NAME is actually
optional if the TWO_TASK variable and database SID are the same, but it's
good practice to use it, in any case.)
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Application Hangs Upon Connecting to the TCF Server
Make sure you try connecting using the ServerControl class if hanging problems are
reported. If it still hangs, then typically this indicates one of the following:

1. There is a bug in the code, or that there is an environment setup problem.

Check the debug output on the server to see if there's anything obvious that
needs to be corrected, and check the bug database to see if this type of problem
has been previously reported.

2. The wrong protocol was used to establish the connection.

Ensure the TCF server is speaking the same protocol as the client. Supported
protocols are SOCKETS, HTTP, and SSL. The client must use the same protocol
as the Forms server.

3. The TCF server attempts to exit the loop in which it accepts connections from
the client, but does not really do so.

This type of error is probably the most common. In 11.5.2 and above, if the TCF
server stops accepting connections from the client, then it closes the socket and
exits immediately.

Unfortunately, this does not explain why the TCF server stopped accepting
connections in the first place. Determining the reason is a more involved
process. One very possible reason is the TCF server ran out of memory. The
most useful thing to do in this case is to check the debug output and see if any
errors have been logged.

No Resources Are Visible
If you experience problems with the proper display of resources in the Gantt chart,
then perform the steps listed in the following table.

Trouble Shooting the TCF Server

Tip Description

View the JInitiator Console Window
error messages.

View the JInitiator Console Window error messages and the exceptions
thrown.

Consult the TCF server log file. View the TCF server log file for relevant information.

Verify the TCF server status Use the ServerControl class to check whether or not the TCF
server is accepting connections on the host and port on which it
was started.
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View the JInitiator Console Window Error Messages
The single most useful thing that you can do to do to troubleshoot server problems
is check the JInitiator Console window on the client machine. Some debug
information is output by default, and errors raised here are often very descriptive
and give a good indication of what the problem is.

If that window is no longer available, then restart the browser, set the "Show
Console" check box in the JInitiator control panel, and restart the application.

The items listed below are a few of the exceptions that can be thrown, and reported
in the JInitiator Console window.

1. java.net.ConnectException: Connection refused

Usually this means that the TCF server is not running, or that the TCF:HOST /
TCF:PORT profile options are pointing to a wrong server or port.

2. Gantt TCF HOST:<http://hostname> PORT:<port#>

This refers to the TCF:HOST/PORT settings passed into the Gantt chart.

As described in Step 4b: Verify the TCF Hostname and Port Number:

■ If the host name is prefixed with "http://", then the client attempts to
connect to the TCF server using the HTTP protocol.

■ If this prefix is missing, then the client attempts to contact the server using
the SOCKETS protocol.

3. gantt: tcfSetAppsContext <filename>.dbc

The <filename> listed in the error must exactly match the dbc filename that was
specified in the DBC parameter when starting the TCF server. If this is not the
case, then rename the file to match that specified in the DBC parameter.

4. java.lang.ClassNotFoundException:javax.net.ssl.SSLSocket

The client side SSL libraries are meant to be included with JInitiator. However,
in some older versions of JInitiator, this did not happen due to US export
restrictions that have since been lifted.

Caution: If the TCF server and client do not use the same mode,
then the client will not be able to establish a connection.
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Consult the TCF Server Log
If this exception occurs, then you must install the latest version of JInitiator
(1.1.7.32 or higher). If you have access, then download from technet.oracle.com.
If necessary, contact Oracle Support for help with this step.

5. java.io.EOFException
.... < 3-5 lines of text> at
oracle.apps.fnd.tcf.net.SocketServerConnection.readBigUTF(
SocketServerConnection.java)

This exception usually occurs after the client tries to connect to the TCF server
using the wrong communication protocol. The message indicates that the
TCF:HOST profile is not set correctly. Refer to Step 4b: Verify the TCF Hostname
and Port Number for details.

6. gantt: addbar failed, resource not found (<Resource Type> - <Resource Id>)

One common cause for this exception is described in bug 1414546, which is
dependant on Calendar bug 1415863 for resolution. If this is the case, then
ensure that the resource does not have a Calendar Exception assigned that
spans the entire duration of a shift.

7. java.net.UnknownHostException: <host>

This exception is thrown when the TCF:HOST profile is set to a server that is
not recognized by the client.

Verify that the TCF:HOST profile is set correctly, and that the client machine can
access the server using the <host> displayed in the exception.

One way to check is to open a DOS window (on a Windows machine) and type
in "ping <host>." If the host is inaccessible from the client, then the response
returns a "Bad IP address <host>" message.

Consult the TCF Server Log
You can view the TCF server log to obtain further information. To set up the log file
for automatic logging, perform the following steps:

1. Add the following to the command line:

OUTPUTFILE=/tmp/<logfile>.log LOGLEVEL=STATEMENT

2. Bounce (stop and restart) the TCF server.

3. Run the application again.
Troubleshooting Gantt 99



Verify the TCF Server Status
4. Check the log file to see if there is anything in the log file that may indicate
what the problem may be.

If you see the following:

java.lang.NullPointerException
at oracle.jdbc.oracore.OracleTypeNUMBER.unpicklerec(Compiled Code)
at oracle.jdbc.oracore.OracleType.unpicklerec(Compiled Code)
at oracle.jdbc.oracore.OracleTypeCOLLECTION.unpicklerec(Compiled Code
at oracle.jdbc.oracore.OracleTypeCOLLECTION.unpickle(Compiled Code)
at oracle.jdbc.oracore.OracleTypeCOLLECTION.unpickle(Compiled Code)
at oracle.jdbc.oracore.OracleTypeADT.unlinearize(Compiled Code)
at oracle.sql.ArrayDescriptor.length(Compiled Code)
at oracle.sql.ARRAY.length(Compiled Code)
at oracle.sql.ARRAY.getArray(Compiled Code)
at oracle.apps.jtf.gantt.server.GanttDataServer.getShifts

This may be due to bug 1510941. View the AIX Port Instructions, in the Step 2:
Performing the Post Install Steps section for details on how to correct this problem.

Verify the TCF Server Status
You can also use the ServerControl class to check whether or not the TCF server is
accepting connections on the host and port on which it was started.

To do this, log on to the machine where it was started and run:

jre oracle.apps.fnd.tcf.ServerControl STATUS <port#>

One of the following may occur:

■ If the result is some variant of "Unable to connect," the server most likely was
not started properly. See: Unable to Connect to the TCF Server and Unable to
Connect to the Database for details of how to solve this problem.

■ If the application hangs upon connecting, the server has stopped accepting
connections for some reason and must be bounced. See: Application Hangs
Upon Connecting to the TCF Server.

■ If you are able to connect from the ServerControl but not from an application, it
might be an application-specific problem, or it may be that the client JAR files
are not set up correctly.
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Account adjustment
An adjustment to a subledger account, made via journal entries.

Acknowledgment
A token response, indicating that a given request was received.

Acquirer
A financial institution that establishes an account for a merchant and processes
credit card payment authorizations and payments.

Action
A user-initiated step taken to resolve an incident.

Activity
Any data change—including customer, administrator, or system events—that the
system can log for reporting purposes or to trigger e-mail notifications.

Examples of activities:

n User login

n Customer payment of a bill

n Data upload
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Activity logger
The component of the application that records all activities—including customer,
administrator, or system events—for use in reporting and e-mail notifications. See
activity.

Adapter
Mediation layer provided by Service Delivery Platform to interface with various
network elements.

Adapter type
Different kinds of adapter provided by Service Delivery Platform.

Address
A physical location for a customer or a contact.

Adjusted pipeline
The amounts for the latest, committed opportunity-level forecast. The amounts
displayed are the amounts committed by the user or by the user’s subordinates at
the opportunity level.

Advertisement
In iMarketing, an advertisement is a campaign without an offer attached to it.

Advertiser
In iMarketing, an advertiser is an affiliate that displays a merchant campaign
(promotion, survey, ad, event) on its site. Advertisers can be subsidiaries, suppliers,
channel partners, ad networks, portals, and so on.

Affiliate
In iMarketing, affiliates are third parties (subsidiaries, suppliers, channel partners,
ad networks, and so on) that participate in the merchant’s campaigns. Two types of
affiliates are publishers and advertisers.

Aging
In accounting, the activity associated with the amount of time that a customer claim
is unresolved. Claims with comparatively long periods of aging represent funds
that are inaccessible or cannot be accurately measured.
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Alphanumeric number type
An option for numbering documents, employees, and suppliers where assigned
numbers can contain letters as well as numbers.

Alternate unit of measure
All other units of measure defined for an item, excluding the primary unit of
measure.

AMPS
Advanced Mobile Phone Service. An analog cellular voice communication system
that operates in the 800 MHz range.

ANSI
American National Standards Institute, which establishes national standards for the
United States and serves as the North American representative to ISO (International
Standards Organization). The parent organization for X12.

AOL
Applications Object Library.

API (Application Programmable Interface)
A set of procedures that import or export information between an application and
an operating system or other system program.

Application building block
A set of tables and modules (forms, reports, and concurrent programs) that
implement closely-related entities and their processing.

Approve
An action you take to indicate that you consider the contents of a purchasing
document to be correct. If the document passes the submission tests and you have
sufficient authority, Purchasing approves the document.

Asset category
Assets may be grouped by category. All assets in a category share the same asset
cost accounts and depreciation accounts for each depreciation book.
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Asset hierarchy
Assets can be grouped and placed in a hierarchy of larger groups. For example,
computers can be grouped for each floor of a building. The floor groupings can then
be grouped into one logical grouping of computers for the whole building. The
hierarchy would consist of all computers in the building at the top as a parent to
each floor grouping of computers. Each floor grouping is a parent to the individual
computers.

Asset hierarchy batch
Any changes made to a hierarchy are recorded in a batch that, when applied, will
make the changes in your financial books.

Asset hierarchy node
A node represents a logical collection of assets. Several logical groupings (nodes)
can be placed in a hierarchical structure, with the asset records serving as children
of the lowest level logical nodes. Each node can have only one parent but can have
many children.

Asset hierarchy purpose
An asset hierarchy purpose provides a justification for building an asset hierarchy
that serves some useful accounting purpose. At least one asset hierarchy rule must
exist before a purpose can be created. An asset hierarchy purpose is required to
build a hierarchy.

Asset hierarchy rule
An asset hierarchy rule determines the values of attributes for nodes in the asset
hierarchy.

Asset item
Anything you make, purchase, or sell including components, subassemblies,
finished products, or supplies, which carries a cost and is valued in your asset
subinventories.

Asset status
A user-defined field. This field may be used to search for an asset in the Find Assets
window. This field also affects Mass Additions, Mass Transfers, and Batch Transfers.
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Asset subinventory
A subdivision of an organization that represents either a physical area or a logical
grouping of items. An example is a storeroom where quantity balances are
maintained for all items and values are maintained for asset items.

Attachment
A file of any type that is associated with a value such as a customer site, a to do, or
an opportunity. An example is a contract created in a word processing file that is
attached to a customer.

Attribute - Oracle Provisioning
A type identifier.

Attribute, profile
A name-value pair that identifies one of the pieces of information the system asks
the user to provide about him- or herself for a user profile. Examples of profile
attributes: State, FavoriteColor.

There are two types of profile attributes:

n Generic: The attribute is used with all users of that profile type.

n Conditional: The attribute is used with a subset of the users of that profile type
that meet a given condition.

Authentication
An electronic security scheme that requires a user to enter a user name and
password to view certain files or open certain parts of a user interface.

Authorization
The validation of access rights. Authorization uses authentication and evaluation of
constraints to process a request.

Autopay rule
Automatic payment rule. A rule in the database, set up in advance by the customer,
that prompts the system to automatically pay the bills sent to that customer by a
particular biller.

The customer can specify, for a given biller:

n The amount of payment
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n The date on which to pay the bill

n The payment instrument to use

When such a rule is established, the system automatically pays all of that biller's
bills without intervention from the customer until the customer changes the rule.

Autopayment
The automatic payment of bills according to autopay rules set up by the customer.

Availability matrix
A table containing information on the availability of software products. It covers the
various versions of a product classified by platform, with their respective release
dates.

Back to Top

B

Back end payment system
An application used by a biller site to process payment requests for a specific kind
of payment method. For example, one payment system might handle certain kinds
of credit card payments, while another payment system handles only financial
institution (bank) account transfers.

Example of payment systems: CyberCash, Check Free, Verifone.

See financial institution payment system and credit card payment system.

Backflush operation
A routing operation where you backflush component items.

Backflush transaction
A material transaction that automatically issues component items into work in
process from inventory when you move or complete the assembly. Also known as
post-deduct or pull.

Bank account transfer
See financial institution account transfer.
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Bill of material
A list of component items associated with a parent item and information about how
each item relates to the parent item. Oracle Manufacturing supports standard,
model, option class, and planning bills. The item information on a bill depends on
the item type and bill type. The most common type of bill is a standard bill of
material. A standard bill of material lists the components associated with a product
or subassembly. It specifies the required quantity for each component plus other
information to control work in process, material planning, and other Oracle
Manufacturing functions.

Bill-to address
The customer’s billing address. It is also known as invoice-to address. It is used as a
level of detail when defining a forecast. If a forecast has a bill-to address associated
with it, a sales order only consumes that forecast if the bill-to address is the same.

Bill/routing reference
A bill or routing you assign to non-standard discrete jobs. You use the bill reference
to create the material requirements for the job. You use the routing reference to
create the routing for the job.

BOM
Bill of material

BOM item type
An item classification that determines the items you can use as components in a bill
of material. BOM Item types include standard, model, option class, and planning
items.

Bonus
Incentive compensation typically paid for meeting a goal, including quantitative
and qualitative goals.

Booked date
The date that an order is booked, signifying that the order is firm and includes all
the information necessary to be processed through its order cycle.

Browser
See web browser.
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Bug
A product defect or failure. Failure may be exhibited as an outage, incorrect or
undocumented behavior, inaccurate documentation, or performance degradation.

Bundle sequencing
Sequencing of different bundles in an order. One bundle cannot continue until an
earlier bundle completes.

Bundles
Collection of line items of an order.

Business application
Software that performs a particular business function or group of functions
(accounts payable, for example).

Business document
A document used for conducting business between two trading partners—a
purchase order or invoice, for example.

Business process
Business rules for the type of support, such as field or help desk.

Back to Top
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Calculator
A database that uses the data collected by the collector to calculate a compensation
payment.

Campaign
A marketing activity that is displayed on merchant or affiliate web sites. A
campaign can be a promotion, an advertisement, a survey, an event, or a publisher’s
ad.

Capture
Phase in the payment process when funds are transferred from the customer’s
account to the payee’s account for an already authorized transaction.
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Certification matrix
A table containing certified information of the availability of software products. It
covers a range of platforms and products and their respective versions, and clarifies
which combinations do or do not work together.

Channel
A unique route from Service Delivery Platform to the Network Element via a
Service Platform Delivery Adapter.

Classification
A classification of the type of business area that an account or opportunity is
interested in. This can be anything—such as a type of product, a technology, or a
business sector. Classifications are created for you by your system administrator.

Classification rules
A user-defined set of rules used to classify a sales transaction.

Clawback
The amount of compensation credited for a sale that is taken back when the invoice
due date grace period is exceeded.

CLEI code
Common Language Equipment Identifier code. A 10-character code identifying
telecommunications equipment in a uniform, feature-oriented language.

Client
A software application (such as a browser) that requests services, data, or
processing from a server or from another application.

CLLI code (also CLLIA, CLLIZ)
Common Language Location Identifier code. An 11-character code identifying and
describing buildings, non-buildings, equipment locations, and related job functions.

Close date
The date by which you expect your prospect to make a purchase decision. Close
date determines the period for which an opportunity is forecasted.
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Close reason
The reason an opportunity is no longer active. An opportunity closes because it
turns into a sale, is lost to a competitor, or is not a viable.

Code
A unique identifying number used anywhere a unique identifier is required, for
example, event code, advertisement code, letter code, and so forth. Your system
administrator determines if code is user- or system-generated.

Collection
The process of collecting transactions from feeder systems into the application.

Collector
A database that collects the data required to pay compensation.

Column headings
Descriptions of the contents of each column in the report.

Committed amount
The amount you agree to spend with a supplier.

Compensation plan
A collection of plan elements used to calculate a compensation payment. One
compensation plan is assigned to a salesperson for a given period of time. See
source document or source transaction.

Compensation rate
A multiplier on net sales credit. Rate is determined by level of quota achievement,
as defined in a rate table.

Compensation transaction
The smallest logical unit of data on which a compensation payment can be
calculated. Each transaction comprises several attributes, some of which can be
user-defined during implementation.

Competitor
A company that competes with your enterprise.
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Component
A serviceable item that is a part or feature in another serviceable item. Your
customers cannot report service requests against this type of serviceable item
directly. You can reference components when you enter service requests against
actual end item-type serviceable items, or products. For example, if you define three
inventory items, A, B, and C, where A and B are products (end item-type
serviceable items) but C is a component (non-end item-type serviceable item) of A,
you can enter service requests against A and B directly, but not against C. When you
enter a service request against product A, you can reference C because it is a
component of A.

Component item
An item associated with a parent item on a bill of material.

Computer-telephony integration (CTI)
The practice of using a computer to control one or more telephone and
communications functions.

Concurrent manager
Components of your applications concurrent processing facility that monitor and
run time-consuming tasks for you without tying up your terminal. Whenever you
submit a request, such as running a report, a concurrent manager does the work for
you, letting you perform many tasks simultaneously.

Concurrent process
A task in the process of completing. Each time you submit a task, you create a new
concurrent process. A concurrent process runs simultaneously with other
concurrent processes (and other activities on your computer) to help you complete
multiple tasks at once with no interruptions to your terminal.

Concurrent queue
A list of concurrent requests awaiting completion by a concurrent manager. Each
concurrent manager has a queue of requests waiting in line. If your system
administrator sets up simultaneous queuing, your request can wait to run in more
than one queue.
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Concurrent request
A request to complete a task for you. You issue a request whenever you submit a
task, such as running a report. Once you submit a task, the concurrent manager
automatically takes over for you, completing your request without further
involvement from you, or interruption to your work. Concurrent managers process
your request according to when you submit the request and the priority you assign
to your request. If you do not assign a priority to your request, your application
prioritizes the request for you.

Configuration
A product a customer orders by choosing a base version and a list of options. It can
be provided as individual pieces, as a set, or as an assembly (configuration item).

Configuration bill of material
The bill of material for a configuration item.

Configure-to-order
An environment where you enter customer orders by choosing a base model and
then selecting options from a list of choices.

Contact
An individual that works for an account.

Coterminous
Setting the same end date for all ordered or renewed service programs.

Coupon
A consumable promotion. This term is based on the analogous use of coupons you
find in stores.

Credit memo
A document generated when an invoice is fully or partially reversed.

Credit
Phase in the payment process when funds are transferred from the payee’s account
to the customer’s account.
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Credit card payment system
A type of payment system that handles certain kinds of credit card payments only.
These payment systems communicate with payment processors for credit card
payments. They do not require any communications with the Automated Clearing
House network. CyberCash is an example of a credit card payment system.

See back end payment system.

Credit receiver
A salesperson who has been assigned sales credit.

Credit type
A salesperson can receive monetary or non-monetary credit. The credit types are
user-defined. Examples of monetary types are commission and bonus. Examples of
non-monetary types are air miles and holidays.

Crediting transaction
A type of transaction that gives or takes away sales credit after sales credit has been
allocated for an invoice transaction.

CTI
See computer-telephony integration.

Current date
The present system date.

Custom fields
Also known as flexfields. Custom fields are available on most screens. A flexfield
must be set up by the system administrator, include a custom label for the field, and
indicate what type of data is allowed in the field. A key flexfield is indexed, and a
search may be conducted against it or data may be sorted by the field in a report.

Customer number
A system-generated number that uniquely identifies a customer or prospect.

Customized plan
A compensation plan for which you have changed the defaults for quota or
compensation rates, according to the needs of an individual salesperson.
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Customer product
An entity that identifies a serviceable item or customer product. The customer
product identifies not only the product and the customer, but also the product
quantity, the product’s serial number (if the product is under serial number control
and has been assigned a serial number), the location of the product, the various
contacts, such as service administration, support, and bill-to associated with the
product. A customer may have several of the same customer products.

Customer site
A specific area or place, such as a building or a floor on a building, at a customer
address. A customer address may have one or more related customer sites.

Cycle counting
An inventory accuracy analysis technique where inventory is counted on a cyclic
schedule rather than once a year.

Back to Top
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Dashboard
The navigation control panel that is accessible to the user at all times.

Database diagram
A graphic representation of application tables and the relationships among them.

Database view
Provides access to an underlying database table. You do not need to know how the
data is stored to use a database view.

Decision maker
A contact having authority to make purchase decisions.

Default plan
A compensation plan that has user-defined default values for plan elements. When
you assign a base plan to a salesperson, you can customize values in the plan
elements such as the quota, rates, periods, draw amounts, and so forth.
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Delayed service order
An order for service against existing customer products. The service order is
"delayed" because service is ordered later than the product is ordered.

Dequeuer
Process that processes the items of a queue.

Depot repair
A process used to track items returned by a customer for repair or replacement.

Descriptive flexfield
A field you use to collect information unique to your business. You determine the
additional information you need and descriptive flexfield lets you customize your
application to your needs without additional programming.

De-support notice
A brief announcement specifying a platform/product/version combination for
which regular support will no longer be provided as of a certain date.

DHCP
Dynamic Host Configuration Protocol. A protocol that automatically assigns
Internet Protocol (IP) addresses on TCP/IP networks when users log on, thereby
reducing configuration time. DHCP centralizes IP address management on central
computers that run the DHCP server program.

Dimension
A type of hierarchy.

Direct sales credit
Sales credit directly assigned to a salesperson in a transaction in a feeder system,
such as Oracle Order Entry or Oracle Receivables, or a foreign source.

Discount
A reduction of the list price of an item.
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Display rule
In iMarketing, a display rule is an object that selects a campaign (from a group of
eligible campaigns for the specific customer in the session) at run-time (display
time). A display rule can be called from any template, including an iStore template.

Display style
A display style is a template design that specifies how information displays on a
web page. For example, you use one display style to display product A on a special
sale page, and a different display style to display product A on a page detailing
product information.

DMS
Defect Management System.

DNS
Domain Name Server. Server computers connected to the Internet that maintain a
database of domain names and their associated IP address numbers.

Domain name
A unique name that identifies an Internet site that points to one specific server.

Do not mail
A check box indicating the exclusion of this account or contact from promotional
mailings.

Down stream system
A system that a communication company has to have a link with. It can be a system
to provision service, to bill a customer, to register a number for E911, and so forth.

Draw
An advance paid to a salesperson toward future earnings.

Drill down
A term referring to clicking on an item within a screen to open a submenu or
another screen.

Back to Top
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E-commerce
E-commerce builds on e-business, leveraging the Internet supply chain to shift
business from a supply-driven to a demand-driven business model. Internet-based
sourcing and requisitioning puts the customer completely in control and facilitates
the delivery of products and services. The Internet enables e-commerce to connect
and extend the value chain, streamline business processes, lower operational costs,
and improve time to market.

e-Commerce is possible through the use of the latest Internet-based applications,
which can capture older data in various data storage formats from companies and
their suppliers and make it available across current applications.

Electronic payment
Any non paper-based type of payment.

Encryption
The data security practice of scrambling (encrypting) data in such a way that only
an intended recipient can decrypt and read the data.

Engineering change order (ECO)
A record of revisions to one or more items usually released by engineering.

Entity
A data object that holds information for an application.

ESN
Electronic Serial Number. A 32 bit binary number that uniquely identifies each
wireless phone. For analog systems, the ESN along with the Mobile Identification
Number (MIN) comprise the handshake information that identifies each mobile
phone. See also mobile number (MIN or MSISDN).

Event alert
An alert that runs when a specific event occurs that you define. For example, you
can define an event alert to immediately send a message to the buyer if an item is
rejected on inspection.
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Expected purchases
Products or services you expect to sell with this opportunity.

Expense subinventory
Subdivision of an organization, representing either a physical area or a logical
grouping of items, such as a storeroom where no value exists but the quantities may
be tracked.

Back to Top
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Feeder system
An order or billing receivable system that inputs transactions to the database.
Example: Oracle Receivables.

Financial institution (FI) payment system
A type of payment system that handles bank account transfers and certain kinds of
credit card payments. These payment systems communicate with Automated
Clearing House (ACH) networks, credit card systems, or both. See back end
payment system.

Financial institution account transfer
A bank account transfer. The direct transfer of funds, for payment, from a
customer’s financial institution account to a payee’s financial institution account.

finished good
Any item subject to a customer order or forecast. See also product.

Flexfield segment
One part of your key flexfield, separated from the other parts by a symbol you
choose (such as -, /, or \). Each segment typically represents a cost center, company,
item family, or color code.

Forecast
Based upon a sales quota, a forecast of future sales can be entered either by a sales
representative or managers.
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FTP
File Transfer Protocol. Internet tool to transfer files through the Internet from one
computer to another. FTP is used to download files from another computer, as well
as to upload files from your computer to a remote computer.

Fulfillment actions
Re-usable functions used to perform pre-defined provisioning tasks. Used as part of
the fulfillment of a work item.

Fulfillment element
A unique identifiable physical Network Element/Operational Support System
belonging to a fulfillment element type.

Fulfillment procedure
Provisioning Procedure for the fulfillment of service at the fulfillment element.

Fuzzy find
A feature you use to search for a name, address or account for which you are not
sure of the exact spelling or wording. Fuzzy find follows a prescribed set of rules to
accomplish its search.

Back to Top
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Giveback
The payment received for a clawback.

GSM
Global System for Mobile. A digital mobile telecommunications system currently
most prolific in Europe and well established in most countries outside the U.S.

Back to Top
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Hierarchy
A group of related entities arranged in an inverted tree structure according to rank
or successive grades.

Holiday support
An application component that controls the way weekends and holidays affect a
payment system’s lead time—the time it takes the payment system to process a
payment request. Holiday support applies rules to FI payment systems.

Lead time is computed in business days and does not count weekends and
holidays. If a payment system’s normal lead time is two days, and the payment
system receives a request on Friday, the payment may not be processed until
Tuesday. Similarly, if July 4 is a bank holiday and the payment system receives the
request on July 3, the payment may not be processed until July 6.

Payment systems may have their own customized set of holidays. The payment
system may provide a PL/SQL file to use for holiday computation.

HTML
Hypertext Markup Language. A standard format for encoding documents for use
on the World Wide Web.

HTML documents may contain text, graphics, references to programs, and
references (links) to other hypertext (web) documents.

HTTP
Hypertext Transfer Protocol. The protocol that clients use to issue requests for
documents over the Internet.

When HTTP appears at the beginning of a URL, it tells the browser to expect a
hypertext document.

HTTPS
A secure version of Hypertext Transfer Protocol (HTTP). HTTPS coexists with
HTTP and provides security mechanisms to secure transactions between Web
clients and servers.

Back to Top
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ICX
The Inter Cartridge Exchange is an API provided by Oracle Web Server to issue
HTTP requests between cartridges.

IMAP
Internet Mail Access Protocol. An Internet protocol that expands on the features of
POP, an Internet mail server protocol that provides an incoming message storage
system. Like POP, IMAP works in conjunction with SMTP, which moves mail from
one system to another. See also SMTP.

IMEI
International Mobile Station Equipment Identity is a unique electronic serial
number identifying a particular mobile station.

IMSI
International Mobile Subscriber Identity. A unique number identifying a particular
subscriber.

incentive factors
See quota uplift and period.

incentive type
Three types of incentive compose the monetary amount of a compensation
payment: commission, bonus, and manual payments.

incident
An entry logged in to record a customer’s request for product service. You can log a
different incident for each issue a customer reports, including questions about
products, problems using the products, requests for preventive maintenance, and
requests for service contract renewals.

included item
A standard mandatory component in a bill, indicating that it ships (if shippable)
whenever its parent item is shipped. Included items are components of models, kits,
and option classes.
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indirect sales credit
Credit inherited by a salesperson according to his/her place in the salesperson
hierarchy. Indirect credit can roll up from a subordinate to a manager, or across from
a salesperson to a peer.

inspection
A procedure you perform to ensure that items received conform to your quality
standards. You can use inspections to prevent payment for goods and services that
fail to meet your quality standards.

interest
See interest type.

interest code
A code created by your system administrator for an item or business area that you
use to track account, contact, and opportunity interests. Each primary code can
have secondary codes, so that you can break your account and contact interests
down. For example, you might have one product that is available in more than one
version or model. You can create a primary interest code for the product itself and
then link it to a number of secondary codes that represent the different versions or
models.

interest type
A classification of the type of business area in which a contact is interested. This can
be anything—such as a type of product, a technology, or a business sector. Interest
types are created for you by your system administrator.

internal requisition
See internal sales order, purchase requisition.

internal sales order
A request within your company for goods or services. An internal sales order
originates from an employee or from another process as a requisition, such as
inventory or manufacturing, and becomes an internal sales order when the
information is transferred from purchasing to order entry. Also known as an
internal requisition or a purchase requisition.
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inventory transaction
A record of material movement. The basic information for a transaction includes the
item number, the quantity moved, the transaction amount, the accounting flexfields,
and the date. See material transaction.

issuer
A financial institution that establishes an account for a consumer and issues the
payment instrument.

issue transaction
A material transaction to issue component items from inventory to work in process.

item
Anything you make, purchase, or sell, including components, subassemblies,
finished products, or supplies.

item attribute control level
To maintain item attributes at the item master attribute level or the organization
specific level by defining item attribute control consistent with your company
policies. For example, if your company determines serial number control at
headquarters regardless of where items are used, you define and maintain serial
number attribute control at the item master level. If each organization maintains
serial number control locally, they maintain those attributes at the organization
specific level.

item master level attribute
An item attribute you control at the item master level as opposed to controlling at
the organization level.

item sequence
The sequence of the component item on the bill of material used to sort components
on reports.

item specification
See specification.

Item status
Code used to control the transaction activity of an item.
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Item type
Entity in Oracle Workflow that identifies a set of business processes.

Back to Top
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Java
An object-oriented, portable computer language developed by Sun Microsystems
and supported by the Oracle Application Server.

The Oracle Application Server can execute Java directly and send Java programs to
a client’s browser for execution there.

JBC
JavaBeans cartridge.

K

Key indicators
A report that lists statistical receivables and collections information that lets you
review trends and projections. Also, an Oracle Applications feature you use to
gather and retain information about your productivity, such as the number of
invoices paid. You define key indicators periods, and the application provides a
report that shows productivity indicators for your current and prior period activity.

Key site
A site you work with frequently.

Knowledge area
A collection of knowledge objects that pertain to a specific product or other
categorization.

Back to Top
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Latest commitment
The latest amounts committed by the user or by the user’s subordinates at the
product category level for Forecast and Upside statuses. ’None’ is displayed if no
previous commitment was made.

LDAP
Lightweight Directory Access Protocol. A directory service specification that
provides white pages services for an organization, for example, helping people locate
other people or services. A directory service is a database that users can search and
manipulate in a number of ways to display information about a network and its
resources, or to create and manage user accounts. In Oracle Applications, LDAP
refers to the server used for such purposes.

Lead
A potential to sell products and/or services to an account or contact. Leads record
the initial interest a customer or prospect has in making a purchase or in evaluating
a product for purchase. One contact can generate many leads. One marketing
activity can generate many leads. Qualified leads become opportunities.

Life end date (LED)
The date when an asset will be fully depreciated. For example, if an asset with a life
of three years is entered into an accounting book on 1 January 2003, then its LED
will be 31 December 2005.

Line item
Individual products/services part of an order.

Line item sequencing
Line items that do not depend on the start/completion of any other line item (if
any) in an order.

List price
A standard item cost charged to a customer for your product.

Local database
A database that runs on the same machine as the Oracle Application Server.
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Locator
Physical area within a subinventory where you store material, such as a row, aisle,
bin, or shelf.

Back to Top
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Mail merge
A feature of word processing software that lets you personalize a form letter. In
general, two files are involved: a form letter containing both the text that remains the
same and tokens representing information to be personalized and a merge file
containing database information that replaces the tokens, such as a company name
or a contact’s name and address.

Mandatory component
A component in a bill that is not optional. Oracle Applications distinguish
mandatory from optional components in model and option class bills of material.
Mandatory components in pick-to-order model bills are often referred to as
included items, especially if they are shippable.

Manual transaction
A user-entered transaction created for reversing or changing sales credit.

Mapping
Rules defining collection that map the table columns of a feeder system to the
transaction columns in the application.

Mass change order
A record of a plan to replace, delete, or update one or more component items in
many bills of material at the same time.

Mass retirement
A feature that allows you to retire a group of assets at one time. In Oracle Assets,
mass retirements may be made through the Asset Hierarchy or through the Mass
Transactions menus.
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Material transaction
Transfer between, issue from, receipt to, or adjustment to an inventory organization,
subinventory, or locator. Receipt of completed assemblies into inventory from a job
or repetitive schedule. Issue of component items from inventory to work in process.

Merge file
An operating system file that contains information pulled from the database, for
merging into the text of a form letter to personalize it. For example, a merge file
might contain name and address information for 15 contacts. When merged into the
text of a form letter, it produces 15 personalized letters.

Message set
See OFX message set.

Middle ware
Software that sits between two or more types of software and translates information
between them.

Mobile number (MIN or MSISDN)
Mobile Identification Number. The North American standard consists of 10 digits
and follows this sequence: “(###) ###-####”. The European standard consists of 6
digits and follows this sequence: “## ####”. For analog systems, the MIN and the
Electronic Serial Number (ESN) comprise the handshake information that identifies
each mobile phone. See also ESN.

Model bill of material
A bill of material for a model item. A model bill lists option classes and options
available when you place an order for the model item.

Model item
An item whose bill of material lists options and option classes available when you
place an order for the model item.

Module
A program or procedure that implements one or more business functions, or parts
of a business function in an application. Modules include forms, concurrent
programs, and subroutines.
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Multimedia
Multimedia consist of files used to present content on a web page to your customer,
such as graphics, text, audio, and video.

Multimedia component
Multimedia components define the types of media objects available to display on a
web page, such as a certain size picture, short text description, or audio of a certain
length.

Back to Top
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Name-value pair
Used in HTTP communications to pass data. Name-value pairs may be either input
or output.

Net sales credit
The product of the transaction factor and sales credit, given if a salesperson is
eligible. Net sales credit is further multiplied by the compensation uplift to
determine compensation credit.

NLS
National language support.

NNTP
Network News Transfer Protocol. The delivery mechanism for the USENET
newsgroup service. It provides a way to exchange messages, articles, and bulletins
throughout the Internet.

Non-standard discrete job
A type of discrete job that controls material and resources and collects costs for a
wide variety of miscellaneous manufacturing activities. These activities can include
rework, field service repair, upgrade, disassembly, maintenance, engineering
prototypes, and other projects. Non-standard jobs do not earn material overhead
upon assembly completion.
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Non-standard expense job
A type of non-standard job expensed at the close of each accounting period. Typical
expense jobs include maintenance and repair.

Note
A piece of information about a site, opportunity, or contact. A note is either entered
by you or generated automatically to record the occurrence of a specific situation
such as the receipt of a telephone call from a contact.

Notification
An e-mail message that the system creates and sends automatically to users or other
addressees when certain events occur in the system.

Numeric number type
An option for numbering documents, employees, and suppliers where assigned
numbers contain only numbers.

Back to Top
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Offer rules
Rules used to specify if a promotion applies to a customer during order checkout in
a given web site session.

Offline payment processing
The payment processing model in which a payment processing request is not
immediately forwarded to back-end payment processors.

OFX
Open Financial Exchange. A framework developed by CheckFree, Intuit, and
Microsoft for exchanging financial data and instructions between customers and
their financial institutions.

OFX enables institutions to connect directly to their customers or other institutions
without requiring an intermediary.

OFX is an open specification that anyone can implement: any financial institution,
transaction processor, software developer, or other party. It uses widely accepted
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open standards for data formatting (such as SGML), connectivity (such as TCP/IP
and HTTP), and security (such as SSL).

OFX message
The unit of work in OFX, consisting of a request and response pair and the status
codes associated with that response.

OFX message set
A collection of OFX messages. OFX message sets are the basis for OFX version
control, routing, and security. They are also the basis for the required ordering in
OFX files.

On hold job/schedule
A job or repetitive schedule that is not accepting further activity and is therefore
untransactable.

Online payment processing
The payment processing model in which a payment processing request is
immediately forwarded to the back-end payment processor.

Open interface
A manufacturing function that lets you import or export data from other systems
through an open interface. An example is a bar code reader device accumulating
data you later import into your manufacturing system for further processing.

Open requirement
A Work In Process (WIP) material requirement you have not yet transacted to a
discrete job or repetitive schedule. It equates to the component quantity required
less any quantity issued.

Opportunity
A qualified sales lead with the potential to bring in revenue. An opportunity has a
life span and it eventually closes either because it turns into a sale, is lost to a
competitor, or is a bad opportunity. An opportunity is assigned to one or more
territories based on a variety of criteria and may be worked on by a single sales
representative, by a team of employees, or by a sales partner.
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Opportunity item
A line item associated with an opportunity.

Opportunity number
The unique identifying number for an opportunity.

Option
An optional item component in an option class or model bill of material.

Option class bill of material
A bill of material for an option class item that contains a list of related options.

Option class item
An item whose bill of material contains a list of related options.

Option dependent operation
An operation in a model or option class item’s routing that appears in a
configuration item routing only if the configuration contains an option that
references that operation.

Order analyser
PL/SQL (Service Delivery Platform) procedure used to add/delete/modify
contents of orders.

Order date
The date an order for goods or services is entered. See also work order date.

Order line number
A number that uniquely identifies a specific line of a sales order.

Order number
A number that uniquely identifies a sales order.

Order type
A classification of a sales order.
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Organization
An entity that can conduct business with your company. An organization can
consist of multiple sites and may have multiple contacts associated with it.

Organization-specific level attribute
An item attribute you control at the organization level.

Original pipeline
Consists of the actual Opportunity amounts, totaled by Won, Forecast, and Upside
statuses.

Outside processing
Performing work on a discrete job or repetitive schedule using resources provided
by a supplier.

Outsource service
A company that provides billers with external web-based bill presentment and
payment. The outsource service acts as a host for one or more billers’ websites.
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Packages
Pre-defined collection of products.

Parent node
An asset hierarchy is built using parent/child relationships. A parent node is a
logical collection of assets or logical grouping of other hierarchy nodes. An asset
record cannot be a parent node. A parent node can have only asset records as
children or only hierarchy nodes as children. It cannot have both.

Parameter form
The HTML form that defines the parameters required for a report. For example, if
the report you are creating is a list of all customers for a particular biller, the user
must be able to enter the name of the desired biller when running the report.
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Partition
A feature of the Oracle 8 database that provides a way to support very large tables
by allowing you to decompose them into smaller and more manageable pieces.
These pieces are called partitions.

After you define your partitions, you can access and manipulate them instead of
manipulating the entire table.

All the partitions of a table have the same logical attributes.

Partner
A company acting on behalf of your enterprise that helps close business for you by
selling your products.

Pay group
A group of pay periods. It is used to identify the payment cycles of a salesperson.
Each pay group may have one or many pay periods.

Pay period
A range of dates over which calculated plan element commissions are collected for
payment.

Payee
The company or other entity, such as a biller, that is being paid in a given
transaction.

Payee account
The account (typically, a bank account) where the proceeds of all payments to a
given payee are transferred.

Payment instrument
A bank account or credit card account that a customer uses for paying bills.

Payment method
A form of payment that a biller accepts for the payment of its bills.

For example, the payment method that National Utility accepts might be credit
cards and financial institution account transfers, while Big Bank Credit Card
Company might accept only financial institution account transfers.
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Payment processing
The process of submitting, authorizing, and returning a payment request and
related data.

Payment state, payment status
The status of a payment in iPayment. The five possible payment states are Pending,
Scheduled, Paid, Failed, and Canceled.

A payment is Scheduled when any of the following conditions apply:

n The customer has scheduled it

n The system has determined that the payment will be paid by autopayment

n The payment was Failed and a CSR has rescheduled it for payment

A payment is Pending when the customer has scheduled it, but the scheduling
system has not sent it to the payment system.

A payment is Paid when it has been completed successfully.

It is Failed when it cannot be paid for any reason, such as insufficient customer
funds.

A payment is Canceled when a CSR has canceled it following a customer dispute or
when he or she has determined for whatever reason that the payment cannot be
rescheduled. Note that a scheduled payment can be canceled as long as the
cancellation occurs before it reaches a bank.

Payment system
An application used by a biller site to process payment requests for a specific kind
of payment method. For example, one payment system might handle certain kinds
of credit card payments, while another payment system handles only financial
institution (bank) account transfers.

Example of payment systems: CyberCash, Check Free, Verifone.

See financial institution payment system and credit card payment system.

Payment uplift
A type of incentive, the payment uplift is a multiplier on the compensation rate. The
payment uplift varies the compensation payment without affecting quota
achievement.
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The account (typically, a bank account) where the proceeds of all payments to a
given payee are transferred.

Pending
A status where a process or transaction is waiting to be completed.

Pending-iPayment
A payment status in which the customer has scheduled the payment but the
scheduling system has not yet sent it to the payment system. See role.

Period
A unit of time, such as one week, two weeks, or a month, on which your accounting
calendar is based.

Period target
The target quota amount for a plan element for each period in the compensation
plan.

Pipeline
An accumulation of the forecasted opportunity purchase lines that contain a status
of Upside or Forecast.

Plan element
Terms defining the conditions a salesperson must meet to be paid compensation
and the amount of compensation to be paid. A plan element includes one or more
revenue classes, quota, transaction factor, incentives and compensation rate.

Point code
A unique code that identifies a network node so that the SS7 network can route calls
properly.

Point of presence (POP)
A location where dial-up phone lines or leased line connections exist for Internet
connection to an Internet service provider. Do not confuse with POP (Post Office
Protocol).
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POP
Post Office Protocol. Do not confuse with point of presence (POP). An Internet mail
server protocol that provides an incoming message storage system. POP works in
conjunction with SMTP, which moves mail from one system to another. See also
SMTP.

Posting
In iMarketing, posting is a campaign that is displayed by publishers or is displayed
on advertiser sites (could be driven by a display rule). Posting is usually associated
with terms of contract such as the display program, billing rate, effectivity dates,
and so on.

PPP
Point-to-Point Protocol. A scheme to encapsulate and transmit Internet Protocol (IP)
datagrams over serial point-to-point links. PPP provides router-to-router,
host-to-router, and host-to-host connections.

Primary code
See interest code.

Primary routing
A list of the operations you most frequently perform to build a product. The
primary routing is the default routing for defining a job and calculating
manufacturing lead times.

Privilege
The right or ability to perform an operation in the system.

See role.

Proactive knowledge
Information that is created based on analysis of customer need with the primary
purpose of minimizing service requests. Typically, this information can be technical
bulletins, white papers, FAQs, alerts, availability matrices, step-by-step instructions,
and so forth.

Process
A set of Oracle Workflow activities that need to be performed to accomplish a
business goal. See process activity, process definition.
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Process activity
An Oracle Workflow process modelled as an activity so that it can be referenced by
other processes; also known as a subprocess. See also process.

Process definition
An Oracle Workflow process as defined in the Oracle Workflow Builder. See also
process.

Product
A finished item that you sell. See also finished good.

Product catalog
Summarized product information can be searched for and viewed in the product
catalog along with any additional files relating to the product.

Product category
A product category is a concatenation of interest type, primary interest code, and
secondary interest code, or it is an inventory item description.

Profile option
A set of changeable options that affect the way your applications run. In general,
profile options can be set at one or more of the following levels: site, application,
responsibility, and user.

Promotion
In iMarketing, a promotion is a specific type of campaign with a discount value. It
impacts the price of the item bought, the shipping charge, and the order amount
during the checkout process. A promotion is associated with modifiers such as 2%
off on the order.

Prospect
A company or other entity that has not yet placed a purchase order with your
enterprise.

Protection level
In Oracle Workflow, a numeric value ranging from 0 to 1000 that represents who the
data is protected from for modification. When workflow data is defined, it can
either be set to customizable (1000), meaning anyone can modify it, or it can be
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assigned a protection level that is equal to the access level of the user defining the
data. In the latter case, only users operating at an access level equal to or lower than
the data’s protection level can modify the data.

Proxy server
Proxy server services run on a firewall server at the application level to protect
internal resources on networks from other networks, such as the Internet. Proxy
server services include controls for Web services and file transfer services.

Publisher
In iMarketing, a publisher is an affiliate that displays its ad on the merchant site.
Publishers can be subsidiaries, suppliers and channel partners, ad networks,
portals, and so on.

Purchase order (PO)
A document used to buy and request delivery of goods or services from a vendor.

Purchase requisition
An internal request for goods or services. A requisition can originate from an
employee or from another process, such as inventory or manufacturing. Each
requisition can include many lines, generally with a distinct item on each
requisition line. Each requisition line includes at least a description of the item, the
unit of measure, the quantity needed, the price per item, and the Accounting
Flexfield you are charging for the item.

Purchased assembly
An assembly that you normally buy.

Purchased item
An item that you buy and receive. If an item is also an inventory item, you may also
be able to stock it.
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Quantity
The number of items ordered on a sales order line.
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Qualified lead
A lead becomes qualified when it appears likely to lead to a sale. Leads can be set to
"qualified" by a sales representative, or automatically, if the information in a lead
meets criteria preset by the application administrator. For example, a lead can
become qualified automatically as soon as a telemarketer makes entries in the Time
Frame, Budget and Budget Status fields.

Queue
An intraoperation step in an operation where assemblies are waiting to be worked
on, or service requests are waiting for response. The default intraoperation step for
every operation in a routing.

Quota
A revenue goal for a sales representative that affects compensation.

Quota achievement
Accumulated performance against a quota that determines the compensation rate.

Quota credit
The product of the net sales credit and quota uplift. Quota credit is added to a
salesperson’s quota achievement.

Quota percent
For an expected purchase, the percentage of the amount that you can claim as credit
toward your quota. If you enter a value here, the system automatically calculates
the Quota Credit.

Quota type
You can choose to view forecasts of actual revenue amounts or non-revenue
amounts used for quota credits. Non-revenue amounts are created only for the
purposes of sales representative remuneration.

Quota uplift
A type of incentive, the quota uplift is a multiplier on net sales credit, resulting in
higher or lower quota credit applied toward the quota.
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Quote
A quote is a list of items and prices presented to a prospect. It is created by a sales
representative when a contact, agreement, price list, and ship to site have been
specified.
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Rate bracket
A range of achievement associated with a compensation rate. Also called a rate tier.

Rate table
A structure that associates compensation rates with brackets.

Reactive knowledge
Information created in real time mode based on information contained within a
service request. Typically in the form of a product/solution.

Reconciliation
The process by which a payee and it’s bank exchange transaction report and match
their records.

Reference
A check box that indicates whether a customer, site, or contact is trusted enough to
act as a reference to other prospects.

Remaining useful life (RUL)
The remaining accounting periods for which an asset may be depreciated. For
example, if an asset is entered into your system with a useful life of five years, then
in its third year of service, that asset will have an RUL of two years.

Renewal order
An order containing service order lines to renew or extend existing services applied
to products.

Requisition
See purchase requisition and internal sales order.
Glossary-40



Return
The process of transfer of funds from the payee’s account to the customer’s account
in which the orderID is available.

Return material authorization (RMA)
Permission for a customer to return items. Receivables allows you to authorize the
return of your sales orders as well as sales made by other dealers or suppliers, as
long as the items are part of your item master and price list.

Revenue amount
For an expected purchase, each item, the amount you can roll upwards on a revenue
forecast.

Revenue class
A user-defined category of business revenue. Revenue classes are assigned to plan
elements and help determine if sales credit is applied toward a compensation
payment.

Revenue class hierarchy
A hierarchical arrangement of revenue classes and their subclasses in which you
define very broad classes at the top of the structure. A revenue class hierarchy
makes it possible to pay compensation for a broad revenue class without specifying
all its subclasses.

Revenue classification rules
A set of one or more conditions a revenue class must have to classify into a given
revenue class.

Revenue percent
For an expected purchase, the percentage of the amount that you can roll upwards
on a revenue forecast. If you enter a value here, the system automatically calculates
the Revenue Amount.

Revised component
Component changes to an assembly that is a revised item on an ECO.
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Revised item
Any item you change on an engineering change order. Revised items may be
purchased items, subassemblies, finished goods.

Revised item status
A classification you can use to track and control a revised item’s life cycle. Revised
item statuses include Open, Released, Scheduled, Hold, Implemented, and
Cancelled.

Revision
A particular version of an item, bill of material, or routing.

Revision control
An inventory control option that tracks inventory by item revision and forces you to
specify a revision for each material transaction.

Revision quantity control
A condition placed on an item that ensures that you always identify an item by its
number and its revision. Certain items require tighter controls than other. For
instance, you may want to control the quantities you have in inventory for an item
by revision. For another item, you may just want to know the quantities you have
on hand across all revisions. You keep track of inventory quantities by revision
when an item is under revision quantity control. You keep track of inventory
quantities by item when an item is not under revision quantity control.

Risk factor
Information that an electronic commerce application finds fit to use to evaluate risk
of the customer.

Risk factor score
A number from 0-100 that assigns a risk value for a risk factor.

Risk formula
A formula that is based on multiple risk factors and used by a merchant to evaluate
the risk of the customer.
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Risk Management (iPayment)
A new functionality provided by iPayment for electronic commerce applications
both for business-to-business and for business-to-consumer models. iPayment
includes a number of built-in risk factors and provides the option to the payees to
run or not run the risk evaluation for each payment operation.

Risky Instruments Upload Utility (iPayment)
A Java application used to store risky payment instruments.

Role
A group of related privileges.

See privilege.

Roll across
In a hierarchy, nodes at the same level in the hierarchy branches. For example, in a
salesperson hierarchy, credit rolls across to one or more of a salesperson’s peers who
are at the same level in the organization.

Rollup
In a hierarchy, all ancestors of a node. For example, sales credit rolls up the
salesperson hierarchy from the direct credit receiver to all salespeople above him in
the credit chain.

Rollup territory
A territory without rank or group that represents a region. Your rollup territories
can be customer-based, geographically-based, product-based or any combination of
these and other factors. Each rollup territory is of a particular territory type and is
defined by a set of territory values.

Route sheet
A report that provides full routing, operation, resource, and material requirement
details for jobs and repetitive schedules. Typically used to know how, when, where,
and who builds an assembly. Also known as traveler.

Routing
A sequence of manufacturing operations that you perform to manufacture an
assembly. A routing consists of an item, a series of operations, an operation
sequence, and operation effective dates.
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Routing revision
A specific version of a routing that specifies the operations that are active for a date
range.

Run
An intraoperation step where you move assemblies that you are working on at an
operation.
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Safety stock
Quantity of stock planned to have in reserve in inventory to protect against
fluctuations in demand or supply.

Sales channel
A method used to generate a sales order, such as telemarketing, direct marketing or
sales partner. Sales Channels are set up by the administrator using QuickCodes.

Sales credit
An amount of revenue or non-revenue credit awarded to a salesperson. See also
indirect sales credit.

Sales credit adjustment
A change in the amount of sales credit assigned to a salesperson by an order or
billing system. The change may be retroactive. See also account adjustment.

Sales group
A sales organization within your enterprise that has a manager.

Sales partner
A company acting on behalf of your enterprise helping close business for you by
selling your products. Examples of sales partners are reseller or dealer.

Sales rep
A sales representative or salesperson.
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Sales rep territory
A sales area that you assign to an employee or team. Your sales rep territories can be
customer-based, geographically-based, product-based or any combination of these
and other factors. You can also base a sales rep territory on any number of rollup
territories such that the sales rep territory automatically inherits the qualifier values
of the rollup territories. Each sales rep territory is of a particular territory type
within a particular territory group, and has a rank.

Sales stage
A defined step in the sales cycle. Your implementation team defines permissible
values based on the sales methodology employed by your sales organization.

Sales status
A defined step in the sales cycle. Your enterprise’s implementation team defines
permissible values based on the sales methodology employed by your sales
organization.

Sales team
A sales team is a group of sales representatives and partners associated with a
particular site or opportunity. Members of sales teams can be assigned
automatically by the territory assignment program and may belong to different
sales groups and reporting hierarchies. Each sales team has at least one sales team
leader.

Salesperson
Any entity receiving sales-related incentive compensation including direct
salespeople, managers, external agents, distributors, VARs, and customers.

Salesperson hierarchy
A hierarchical arrangement of salespeople in an organization that specifies the
relationships between managers and their subordinates.

Scrap
An intraoperation step where you move assemblies that cannot be reworked or
completed.

Scrap account
An account that you may use to charge scrap transactions.
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Scheduler
The application component that schedules payment requests to back end payment
systems and updates the system at regular intervals.

On a regular basis, the scheduler schedules payments and sends and receives
payment status updates.

Schema
A collection of database objects associated with a single user or logon account, such
as the roles, privileges, views, data files, tables, and tablespaces associated with that
account.

Secondary code
See interest code.

Section
You can group products for sale into sections and arrange the sections into a
hierarchy. The hierarchy is used to move your customer through your webstore.

Selling price
List price less any discounts.

Serial number
A number assigned to each unit of an item and used to track the item.

Serial number control
A manufacturing technique for enforcing use of serial numbers during a material
transaction.

Serialized unit
The unique combination of a serial number and an inventory item.

Service
A benefit or privilege that can be applied to a product. In Oracle Applications, if the
items you define are categorized as serviceable items, then you can order or apply
service to those serviceable items.

Products offered by carriers.
Glossary-46



Service contract
A support license.

Service contract detail
Lines that specify start dates, end dates, product and coverage types.

Service designator
A number or string of characters that uniquely identifies a product or service that a
communications service provider has sold to a customer. For example, a phone
number or an e-mail address may serve as a service designator.

Service item
An inventory item used to define a service program or warranty. Service items can
be recorded against serviceable products. A synonym for serviceable item is a
serviceable product.

Service item feature
A particular service component, such as implementation or telephone support, that
you include with a service item. When you classify an inventory item as a service
type item and enter the service program-related attributes for it, you can list the
specific services your service item includes.

Service material
Material used for the repair and/or maintenance of an assembled product.

Service order
An order containing service order lines. Service may be for new products or for
existing, previously ordered products.

Service program
A billable service item. Usually a service that customers purchase in addition to a
product’s base warranty.

Service person
An employee whose function is to provide support and service to customers.
Service person is also a synonym for service specialist.
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Serviceable item
An inventory item that your organization supports and services, either directly or
through the supplier of the item, regardless of who actually manufactures the item.
A serviceable item can be an end item, both an end item and a component or part in
other end items, or just a component.

Serviceable item class
A category that groups serviceable items. Each class must be of the type Serialized
or Non-Serialized. You can group serialized serviceable items in a serialized
serviceable item class. You can group non-serialized serviceable items in a
non-serialized serviceable item class. A given item may be the member of only one
item class at any given time.

Serviced customer product
An entity that identifies a service your customer has recorded against a particular
product installation. If you order service against a product, then the application
automatically links the product and the service being recorded against the product
by creating a serviced customer product. A customer product installation may have
more than one serviced product.

Serviced installation
A synonym for serviced customer product.

Servlet
A Java program that runs as part of a network service, typically an HTTP server. It
responds to requests from clients. A servlet is commonly used to extend a web
server by generating web content dynamically.

SET
The Secure Electronic Transaction protocol. An open standard developed jointly by
Visa and MasterCard to ensure the privacy and security of credit card transactions
over open networks such as the Internet.

Settlement
A process including capture, voids, returns, and credits.

SLA
Service level agreement
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SR
Service request

Set of books
A financial reporting entity that partitions general ledger information and uses a
particular chart of accounts, functional currency, and accounting calendar. This
concept is the same whether or not the Multi-organization support feature is
implemented.

Ship to
The address of the customer who is to receive products listed on the invoice or
order.

Ship-to address
A location where items are to be shipped.

SIM
Subscriber Identification Module. GSM (the European Global System for Mobile
system) employs signal encryption via the SIM, a programmable smart card that
slips into a slot built into the mobile phone handset. The SIM card also provides
personal mobility. It contains identification information so all subscribed to services,
regardless of the subscriber’s location, are available by inserting the SIM card into
any accessible GSM mobile phone. See also GSM.

Site
A specific location (address) for a customer or prospect. There can be many sites
associated with one customer or prospect.

Sites
A Web site, such as a consolidator site or biller site.

Site code
A system-generated number that uniquely identifies a site.

SMTP
Simple Mail Transfer Protocol. The Internet mail exchange protocol responsible for
moving messages from one e-mail server to another. E-mail servers run a
message-handling protocol called POP (Post Office Protocol) or IMAP4 (Internet
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Mail Access Protocol, version 4). SMTP is like the mail carrier, responsible for
transporting mail, while POP and IMAP4 are like the post office, responsible for
receiving, storing, and forwarding mail. See also entries for POP and IMAP.

Source document or source transaction
Transactions collected from a feeder system. Examples include orders, invoices, and
credit memos. See also compensation plan.

Source line
Source information tracking where an asset came from. This includes information
from capital asset and accounts payable systems, as well as information added
manually.

Spare part
A synonym for service part. It is an inventory item used without modification to
replace an original part during the performance of maintenance or repair to a
serviceable item or product.

Specification
Describes the requirements of a product in Oracle Quality. You can define
specifications for the key characteristics of the products you produce.

SSL
Secure Sockets Layer. A standard for encrypting data that flows between a browser
and a server, commonly used by payment systems for secure transactions.

Standard bill of material
A bill of material for a standard item, such as a manufactured product or assembly.

Standard costing
A costing method where a predetermined standard cost is used for charging
material, resource, overhead, period close, job close, and cost update transactions
and valuing inventory. Any deviation in actual costs from the predetermined
standard is recorded as a variance.

Standard discrete job
A type of discrete job that controls material and resources for standard production
assemblies.
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Standard item
Any item that can have a bill or be a component on a bill except planning items,
option classes, or models. Standard items include purchased items, subassemblies,
and finished products.

Standard operation
A commonly used operation you can define as a template for use in defining future
routing operations.

Standard unit cost
The unit cost you may use to cost all material and resource transactions in your
inventory and work in process system. This cost represents the expected cost for a
component or assembly for a specified interval of time. The basis for standard cost
may be the cost history, purchase order history, or predicted changes in future costs.

Standard warranty
A standard coverage type bundled with all sales of a particular product.

Start date
The date you plan to begin production of assemblies in a discrete job.

Status
See payment status.

Subassembly
An assembly used as a component in a higher level assembly.

Subinventory
Subdivision of an organization, representing either a physical area or a logical
grouping of items, such as a storeroom or receiving dock.

Supply type
A bill of material component field that controls issue transactions from inventory to
work in process. Supply types supported by Work in Process include: Push,
Assembly pull, Operation pull, Bulk, Supplier, Phantom, and Based on bill.
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Support site
A support territory (as opposed to a sales territory).

Supported product
An Oracle product and version combination for which technical assistance and
error correction is provided.

System
A grouping of customer products.
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Tablespace
An area of a database where a defined group of tables is stored.

Target segment
Defines a group of related customers. A segment may be associated with a set of
campaigns. iMarketing checks the segments a customer belongs to, and determines
the campaigns eligible for the customer. A segment can be organized hierarchically
and can have up to one parent segment. The set of customers in a segment is always
a subset of the customers in its parent segment.

Target segment rule
In iMarketing, a conditional statement associated with a target segment.

Target
A revenue goal associated with a single revenue class. Targets do not affect the
compensation payment.

Target quota
A revenue goal for a salesperson associated with a plan element. Target quotas do
not affect the compensation payment.

Template
Specifications written in HTML that control the appearance and characteristics of an
HTML document, such as a web page.
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Territory
An artificial aggregation of accounts, contacts, or leads.

Territory group
A territory group is a set of territory types that compete with each other when
assigning leads and accounts to employees by territory. For a particular lead or
account, access is granted to the employees whose territories rank highest within
each territory group.

To move
An intraoperation step where assemblies can either be completed to a subinventory
or wait to be moved to another operation.

Total product value
The total product list value less the total product discount value.

Total order value
The total product value plus the total service value.

Total commitment value
The dollar value of a contractual guarantee, with a customer, for future purchases.

Transaction attribute
A single piece of information required to calculate compensation earnings. For
example, a salesperson’s name or an employee ID.

Transaction date
The date you enter and Oracle Manufacturing maintains for any manufacturing
transaction. The date must fall within an open accounting period and be greater
than the release date for transactions on a discrete job or repetitive schedule.

Transaction factor
A multiplier on sales credit that determines net sales credit given for each type of
transaction.

Transaction manager
A concurrent program that controls your manufacturing transactions.
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Transaction worker
An independent concurrent process launched by a transaction manager to validate
and process your manufacturing transactions.
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Unit of measure (UOM)
The unit in which the quantity of an item is expressed.

Unit of measure class
A group of units of measure and their corresponding base unit of measure. The
standard unit classes are Length, Weight, Volume, Area, Time, and Pack.

Unit of measure conversions
Numerical factors that enable you to perform transactions in units other than the
primary unit of the item being transacted.

UOM
See unit of measure (UOM).

URL
The Universal Resource Locator. The address for any file of text, graphic, sound, or
video information displayed on the World Wide Web.

User currency
The currency which the user has defined as the preferred currency.

V

Void
Removing a particular transaction from the records.

Back to Top
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Warranty
A non-billable, zero-monetary service item attached directly to a product at
shipment.

Web browser
Software that enables a user to view information (browse) on the World Wide Web
using HTTP.

Web server
A server connected to the Internet that stores documents and files and can display
them to people accessing the server.

Win probability
The likelihood that the opportunity can close as a win by the expected close date.
Your implementation team determines permissible values. Win probability can be
linked to status so that status automatically updates when win probability changes.

Work in Process (WIP) accounting class
A set of accounts that you use to charge the production of an assembly. You assign
accounting classes to discrete jobs and repetitive schedules. Each accounting class
includes distribution accounts and variance accounts. Also used in cost reporting.

Work in Process (WIP) move resource
A resource automatically charged to a discrete job or repetitive schedule by a move
transaction. Resources are automatically charged when a forward move occurs, and
uncharged when a backward move occurs.

Work items
Functions to be performed as part of the fulfillment of a service.

Work order date
The date to begin processing the paperwork for the discrete job. This date is offset
from the start date by the preprocessing lead time.
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Worker
An independent concurrent process that executes specific tasks. Programs using
workers to break large tasks into smaller ones must coordinate the actions of the
workers.

Workflow Engine
The Oracle Workflow component that implements a workflow process definition.
The Workflow Engine manages the state of all activities, automatically executes
functions, maintains a history of completed activities, and detects error conditions
and starts error processes. The Workflow Engine is implemented in server PL/SQL
and activated when a call to an engine API is made.

X

XML (extensible Markup Language)
XML is a method for putting structured data into a text file. It is a subset of SGML
(Standard Generalized Markup Language), which is a system for tagging and
organizing elements of a document (in the case of XML, that document is a text file).
’Structured data’ would appear in such things as spreadsheets, configuration
parameters, or financial transactions. Applications that produce such data often also
store it on disk in either a binary or text format. If the data is stored in text, you can
view it without having access to the application that created it. XML is a set of rules,
guidelines, and conventions for designing text formats for such data in such a way
that it is easy for computers to generate and read. Using XML to define data avoids
such pitfalls as ambiguity, lack of extensibility, lack of support for
internationalization or localization, and platform dependency.

Back to Top

Y

Z

Glossary-56


	Contents
	Send Us Your Comments
	Preface
	Intended Audience
	Structure
	Related Documents
	Other Sources of Information
	Documentation Accessibility
	Accessibility of Code Examples in Documentation

	Implementing Territory Manager
	Related Documentation and Resources
	Setting Up Territory Manager
	Territory Planning
	Enabling Existing Qualifiers

	Implementing Resource Manager
	Related Documentation and Resources
	Setting Up Resource Manager
	Defining Role Types
	Defining Resource Roles
	Defining Dynamic Groups
	Setting Profile Options
	Workflows in Resource Manager

	Implementing Notes
	Related Documentation and Resources
	Post-Installation Set Up Tasks for Oracle Notes
	Setting Up Note Types
	Defining Note Types
	Mapping Note Types To a Source
	Setting Up the Source Object Code and Context
	System Profile Options

	Implementing Calendar
	Related Documentation and Resources
	System Profile Options
	Defining a Calendar

	Implementing Task Manager
	Dependencies for Tasks
	Related Documentation and Resources
	Setting Up Oracle Tasks
	Defining Task Status
	Determining Task Priority
	Defining Task Types
	Defining a Status Transition and Assigning Rules
	Designing Task Templates
	System Profile Options
	Workflows

	Implementing Interaction History
	Release Dependencies
	Related Documentation and Resources
	Setting Up Interaction History
	Troubleshooting Implementation of Interaction History
	Setting Profile Options
	Workflows in Interaction History

	Implementing Fulfillment
	Release Dependencies
	Related Documentation and Resources
	Setting Up a Fulfillment Administrative User
	Assigning the JTF_FM_ADMIN Role to the Administrator
	Assigning the JTF_FM_Administrator Responsibility to the Application Administrator
	Defining and Configuring the Fulfillment Server
	Defining Resource Groups and Assigning Groups to Servers
	Configuring Email Servers
	Archiving Sent Emails
	Configuring Fax Servers
	Configuring File Servers
	Configuring Printers
	Creating Groups for Servers
	Creating a New Template
	Adding a Master Document to a Template
	Inserting Collateral into a Template
	Setting Up and Starting the Fulfillment Server
	Setting up Remote Command of the Fulfillment Server
	Modifying Startup Scripts for Remote Commands
	Sending Remote Commands through a Script File
	System Profile Options

	Implementing Assignment Manager
	Related Documentation and Resources
	Setting System Profile Options

	Implementing the Business Rule Monitor
	Related Documentation and Resources
	Setting Up The Business Rule Monitor
	Defining the Owner of the Workflow Process
	Setting System Profile Options
	Starting the Background Workflow Processes
	Starting the Business Rule Monitor
	Defining a Business Rule
	Verifying Escalation Territory Creation

	Implementing Dynamic Tables
	Creating a New Dynamic Table

	Administering Gantt
	What is a Gantt Chart?
	What is TCF?
	Implementing the TCF Servers for Gantt
	Step 1: Installing any Required Patches
	Step 2: Performing the Post Install Steps
	Step 3: Configuring the Servers
	Step 4: Verifying the Server Configurations

	Troubleshooting Gantt
	Common Issues
	General Advice
	Gantt Chart Does Not Appear
	Cannot Connect to TCF Server
	No Resources Are Visible
	View the JInitiator Console Window Error Messages
	Consult the TCF Server Log
	Verify the TCF Server Status

	Glossary

